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THANK YOU

Thank you for choosing Analog Way. By following these simple steps, you will be able to operate 
the powerful OPS300.
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This mode allows for a single OPS300 to seamlessly switch and blend any of its 12 analog/digital inputs with 
any other of the inputs, add PIP, titling or logo insertion to the live frame, while previewing your every move 
before going live, to avoid embarrassing errors on your main screen. The Mixer mode is the OPS300 native 
mode, and with no less than 6 layers (of which 3 live layers). The OPS300 with the Video output allows to 
have a full Main screen for recording or broadcasting.

This mode turns your OPS300 into a true 12x2 scaled matrix, while preserving seamless switching capabilities. 
Output #1 and #2 can be set to different resolutions and rates. Switching between any of the inputs can be 
done with the various effects (Cut, Fade, Slides…) and synchronized on both outputs.

* NOTE *  This mode leads the following restrictions: no PIPs, no logos and no frames.

INTRODUCTION

1-1. THE OPS300 OPERATING MODES

Before you start setting up your OPS300 for the first time, be sure you know what you actually want to do with 
it. The OPS300 offers a choice of two operating modes, which results in a versatile video production tool for 
live event staging and fixed installation applications.

* NOTE * : We recommend resetting the device to its default values every time you set up your shows or 
events (see the “Operating The OPS300” chapter, p25).

MIXER MODE

MATRIX MODE
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PIP: a PIP (Picture In Picture), is a picture, typically of reduced size, which is positioned over another 
background image or PIP.  PIPs can be reduced, enlarged and bordered. PIPs can overlap, depending on 
their visual priority.

OPS300 allows for Dynamic PIP on the opening and closing of the sequence, vertically or horizontally. A 
“flying” PIP is also possible over the screen with vertical, horizontal or diagonal animation. A PIP is considered 
as a live layer.

FRAME: a Frame is a full screen image which is selected from one of the eight still frames which you can 
capture with the OPS300. A Frame can be flash captured from any video or computer source plugged into 
the machine (8 max).

LOGO: a Logo is a partiel screen image that can be flash captured from any Video or Computer source, by 
keying or image cut-out. OPS300 can record up to 8 still logos. They can be positioned anywhere on the 
screen. An animated logo is also available on the eighth input.

KEYING: a Key is an electronic process whereby an image is electronically superimposed over another 
source or background, by cutting out either a color (Chroma Key), or its brightness or luminance levels (Luma 
Key). Keys are typically used for titles, logos and special effects. OPS300 allows to use a live source with 
green or blue background and to key it over any other live input.

1-2. USEFUL TERMS AND DEFINITIONS

BACKGROUND: a Background is a source, typically originating from a computer. OPS300 enables you to 
work with live or still (frame) background sources - visually in back of all other sources.

LAYER: a Layer is an image display element (such as a PIP window, Key, Logo(s) or Background) that has 
an associated visual priority — either in front (or in back) of another layer.

The OPS300 can simultaneously view no less than 6 layers  (3 video or live layers, 
1 frame layer or background and 2 logo layers).
OPS300 can insert up to 2 PIPs on a live background, plus 2 logos.
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CAUTION:

All of the safety and operating instructions should be read before the product is operated and should be 
maintained for further reference. Please follow all the warnings regarding this product and its operating 
instructions.

•	 WARNING: To prevent the risk of electric shock and fire, do not expose this device to rain, humidity, 
intense heat sources (such as heaters and direct sunlight). Slots and openings in the device are provided 
for ventilation and to avoid overheating. Make sure the device is never placed near a textile surface that 
could block the openings. Also keep away from excessive dust, vibrations and shocks.

•	 POWER: Only use the power supply indicated on the device of the power source. Devices equipped with 
a grounding plug should only be used with a grounding type outlet. In no way should this grounding be 
modified, avoided or suppressed.

•	 POWER CORD: The device is equipped with a main switch (On (I) /Off (O)). The Switch ON and OFF is 
initiated by the main switch.

�	 Caution: The power cord is the only way to totaly disconnect the equipment from the main power.

	 Apply the following guidelines:
				�    - �The equipment connected to the network must have a release system easily 

accessible and located outside the unit.
				�    - Unplug the power cord, do not pull on the power cord but always on the plug itself.
				    - The outlet should always be near the device and easily accessible.
				�    - �Power supply cords should be routed so that they are not likely to be walked on or 

pinched by items placed upon or against them.

If the power supply cord is damaged, unplug the device. Using the device with a damaged power supply cord 
may expose your device to electric shocks or other hazards. Verify the condition of the power supply cords 
once in a while. Contact your dealer or service center for replacement if damaged.

•	 CONNECTIONS: All inputs and outputs (except for the power input) are TBTS defined under EN60950.

•	 SERVICING: Do not attempt to service this product yourself by opening or removing covers and screws 
since it may expose your device to electric shocks or other hazards. Refer all problems to qualified 
service personnel.

•	 OPENINGS: Never push objects of any kind into this product through the openings. If liquids have been 
spilled or objects have fallen into the device, unplug it immediately and have it checked by a qualified 
technician.

HARDWARE INSTALLATION
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Afin de mieux comprendre le fonctionnement de cet appareil nous vous conseillons de bien lire toutes les 
consignes de sécurité et de fonctionnement de l’appareil avant utilisation. Conservez les instructions de 
sécurité et de fonctionnement afin de pouvoir les consulter ultérieurement. Respectez toutes les consignes 
marquées dans la documentation, sur le produit et sur ce document.

•	 ATTENTION: Afin de prévenir tout risque de choc électrique et d’incendie, ne pas exposer cet appareil à 
la pluie, à l’humidité et aux sources de chaleur intense.

•	 INSTALLATION: Veillez à assurer une circulation d’air suffisante pour éviter toute surchauffe à l’intérieur 
de l’appareil. Ne placez pas l’appareil sur ou à proximité d’une surface textile susceptible d’obstruer 
les orifices de ventilation. N’installez pas l’appareil à proximité de sources de chaleur comme un 
radiateur ou une poche d’air chaud, ni dans un endroit exposé au rayonnement solaire direct, à des 
poussières excessives, à des vibrations ou à des chocs mécaniques. Ceci pourrait provoquer un mauvais 
fonctionnement et un accident.

•	 ALIMENTATION: Ne faire fonctionner l’appareil qu’avec la source d’alimentation indiquée sur l’appareil. 
Les appareils doivent être obligatoirement connectés sur une source équipée d’une mise à la terre efficace. 
En aucun cas cette liaison de terre ne devra être modifiée, contournée ou supprimée.

•	 CORDON D’ALIMENTATION: Les appareils sont équipés d’un interrupteur général (Marche I / Arrêt O), 
la mise en tension et la mise hors tension se fait en actionnant cet interrupteur général. 

	� Attention : le cordon d’alimentation constitue le seul moyen de débrancher l’appareil totalement de 
l’alimentation secteur. Pour être certain que l’appareil n’est plus alimenté, ce cordon doit être débranché 
de la prise murale.

 
	 Appliquer les consignes suivantes:
	 -	� Le matériel relié à demeure au réseau, doit avoir un dispositif de sectionnement facilement accessible 

qui doit être incorporé à l’extérieur de l’appareil.
	� -	� Débrancher le cordon d’alimentation de la prise murale si vous prévoyez de ne pas utiliser l’appareil 

pendant quelques jours ou plus.
	 -	 Pour débrancher le cordon, tirez-le par la fiche. Ne tirez jamais sur le cordon proprement dit. 
	 -	 La prise d’alimentation doit se trouver à proximité de l’appareil et être aisément accessible. 
	 -	 Ne laissez pas tomber le cordon d’alimentation et ne posez pas d’objets lourds dessus.

Si le cordon d’alimentation est endommagé, débranchez-le immédiatement de la prise murale. Il est 
dangereux de faire fonctionner un appareil avec un cordon endommagé; un câble abîmé peut provoquer un 
risque d’incendie ou un choc électrique. Vérifiez le câble d’alimentation de temps en temps. Contactez votre 
revendeur ou le service après-vente pour un remplacement.

•	 CONNEXIONS: Toutes les entrées et sorties (exceptée l’entrée secteur) sont de type TBTS (Très Basse 
Tension de Sécurité) définies selon EN 60950.

•	 RÉPARATION ET MAINTENANCE: L’utilisateur ne doit en aucun cas essayer de procéder aux opérations 
de dépannage, car l’ouverture des appareils par retrait des capots ou de toutes autres pièces constituant 
les boîtiers ainsi que le dévissage des vis apparentes à l’extérieur, risquent d’exposer l’utilisateur à des 
chocs électriques ou autres dangers. Contactez le service après-vente, votre revendeur ou s’adresser à 
un personnel qualifié uniquement.

•	 OUVERTURES ET ORIFICES: Les appareils peuvent comporter des ouvertures (aération, fentes, etc...), 
veuillez ne jamais y introduire d’objets et ne jamais obstruer ses ouvertures. Si un liquide ou un objet 
pénètre à l’intérieur de l’appareil, débranchez immédiatement l’appareil et faites-le contrôler par un 
personnel qualifié avant de le remettre en service.

INSTRUCTIONS DE SECURITE
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Allo scopo di capire meglio il funzionamento di questa apparecchiatura vi consigliamo di leggere bene 
tutti i consigli di sicurezza e di funzionamento prima dell’utilizzo. Conservare le istruzioni di sicurezza e di  
funzionamento al fine di poterle consultare ulteriormente. Seguire tutti i consigli indicati su questo manuale 
e sull’apparecchiatura.

•	 ATTENZIONE: Al fine di prevenire qualsiasi rischio di shock elettrico e d’incendio, non esporre 
l’apparecchiatura a pioggia, umidità e a sorgenti di eccessivo calore.

•	 INSTALLAZIONE: Assicuratevi che vi sia una sufficiente circolazione d’aria per evitare qualsiasi 
surriscaldamento all’interno dell’apparecchiatura. Non collocare l’apparecchiatura in prossimità o su 
superfici tessili suscettibili di ostruire il funzionamento della ventilazione. Non installate l’apparecchiatura 
in prossimità di sorgenti di calore come un radiatore o una fuoruscita d’aria calda, né in un posto esposto 
direttamente ai raggi del sole, a polvere eccessiva, a vibrazioni o a shock meccanici. Ció potrebbe 
provocare un erroneo funzionamento e un incidente.

•	 ALIMENTAZIONE: Far funzionare l’apparecchiatura solo con la sorgente d’alimentazione indicata 
sull’apparecchiatura. Le apparecchiature queste devono essere obbligatoriamente collegate su una 
sorgente fornita di una efficiente messa a terra. In nessun caso questo collegamento potrà essere 
modificato, sostituito o eliminato.

•	 CAVO DI ALIMENTAZIONE: Gli apparecchi con un interrutore (commutatore) generale 
(Accesso I : Speuto 0), accendere ou spagnere l’apparecchio si fa usando l’interrutore.  

	� Attenzione: il cavo di alimentazione è il solo modo di disconnettere l’apparecchio dell’alimentazione. Per 
assicurarsi che totalemente l’apparecchio non è più collegato, il cavo deve essere disconesso della presa 
murale.

	 Seguire le instruzioni seguenti:
	 -	� Il materiale collegato a residenza alla rete, deve avere un dispositivo di sezionamento facile da 

raggiongere eche deve essere inserito all’esterno del apparecchio.
	 -	 Disconnettere l’apparecchiatura dalla presa murale se si prevede di non utilizzarla per qualche giorno.
	 -	 Per disconnettere il cavo tirare facendo forza sul connettore.
	� -	� La presa d’alimentazione deve trovarsi in prossimità dell’apparecchiatura ed essere facilmente 

accessibile.
	 -	 Non far cadere il cavo di alimentazione né appoggiarci sopra degli oggetti pesanti.

	� Se il cavo di alimentazione é danneggiato, spegnere immediatamente l’apparecchiatura.  
E’ pericoloso far funzionare questa apparecchiatura con un cavo di alimentazione danneggiato, un cavo 
graffiato puó provocare un rischio di incendio o uno shock elettrico. Verificare il cavo di alimentazione 
spesso. Contattare il vostro rivenditore o il servizio assistenza per una sostituzione.

•	 CONNESSIONE: Tutti gli ingressi e le uscite (eccetto l’alimentazione) sono di tipo TBTS definite secondo 
EN 60950.

•	 RIPARAZIONI E ASSISTENZA:  L’utilizzatore non deve in nessun caso cercare di riparare l’apparecchiatura, 
poiché con  l’apertura del coperchio metallico o di qualsiasi altro pezzo costituente la scatola metallica, 
nonché   svitare le viti che appaiono esteriormente, poiché ció puó provocare all’utilizzatore un rischio di 
shock elettrico o altri rischi.

•	 APERTURE DI VENTILAZIONE: Le apparecchiature possono comportare delle aperture di ventilazione, 
si prega di non introdurre mai oggetti o ostruire le sue fessure. Se un liquido o un oggetto penetra 
all’interno dell’apparecchiatura, disconnetterla e farla controllare da personale qualificato prima di 
rimetterla in servizio.

INSTRUZIONI DI SECUREZZA
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Um den Betrieb dieses Geräts zu verstehen, raten wir Ihnen vor der Inbetriebnahme alle Sicherheits 
und Betriebsanweisungen genau zu lesen. Diese Sicherheits- und Betriebsanweisungen für einen 
späteren Gebrauch sicher aufbewahren. Alle in den Unterlagen, an dem Gerät und hier angegebenen 
Sicherheitsanweisungen einhalten.

•	 ACHTUNG: um jegliches Risiko eines Stromschlags oder Feuers zu vermeiden, das Gerät nicht Regen, 
Feuchtigkeit oder intensiven Wärmequellen aussetzen.

•	 EINBAU: Eine ausreichende Luftzufuhr sicherstellen, um jegliche Überhitzung im Gerät zu vermeiden. 
Das Gerät nicht auf und in Nähe von Textiloberflächen, die Belüftungsöffnungen verschließen können, 
aufstellen. Das Gerät nicht in Nähe von Wärmequellen, wie z.B. Heizkörper oder Warmluftkappe, 
aufstellen und es nicht dem direkten Sonnenlicht, übermäßigem Staub, Vibrationen oder mechanischen 
Stößen aussetzen. Dies kann zu Betriebsstörungen und Unfällen führen.

•	 STROMVERSORGUNG: Das Gerät nur mit der auf dem Gerät bezeichnete Stromquelle betreiben. Gerät 
mit geerdeter Hauptstromversorgung muss an eine Stromquelle mit effizienter Erdung angeschlossen 
werden. Diese Erdung darf auf keinen Fall geändert, umgangen oder entfernt werden.

•	 NETZKABEL: Da die Geräte über einen Hauptschalter (An I/ Aus 0) verfügen, erfolgt die Stromversorgung 
und -unterbrechung über diesen Hauptschalter. 

	
	 �Achtung: Das Netzkabel stellt die einzige Möglichkeit dar, das Gerät vollständig vom Netzanschluss 

zu trennen. Um sicherzustellen, dass das Gerät nicht mehr versorgt wird, muss dieses Kabel aus der 
Netzsteckdose ausgesteckt werden. 

	 Bitte beachten Sie die folgenden Hinweise: 
	� -	� Wenn Geräte dauerhaft am Netz bleiben, müssen sie über eine leicht zugängliche Trennvorrichtung 

verfügen, die außen am Gerät angebracht sein muss.
	 -	 Das Kabel mittels dem Stecker herausziehen. Niemals am Stromkabel selbst ziehen.
	 -	 Die Steckdose muß sich in der Nähe des Geräts befinden und leicht zugänglich sein.
	 -	 Das Stromkabel nicht fallen lassen und keine schweren Gegenstände auf es stellen.

	� Wenn das Stromkabel beschädigt ist, das Gerät sofort abschalten. Es ist gefährlich das Gerät mit einem 
beschädigten Stromkabel zu betreiben; ein abgenutztes Kabel kann zu einem Feuer oder Stromschlag 
führen. Das Stromkabel regelmäßig untersuchen. Für den Ersatz, wenden Sie sich an Ihren Verkäufer 
oder Kundendienststelle.

•	 ANSCHLÜSSE: Bei allen Ein- und Ausgängen (außer der Stromversorgung) handelt es sich, gemäß EN 
60950, um Sicherheits Kleinspannunganschlüsse.

•	 REPARATUR UND WARTUNG: Der Benutzer darf keinesfalls versuchen das Gerät selbst zu reparieren, 
die Öffnung des Geräts durch Abnahme der Abdeckhaube oder jeglichen anderen Teils des Gehäuses 
sowie die Entfernung von außen sichtbaren Schrauben zu Stromschlägen oder anderen Gefahren für den 
Benutzer führen kann. Wenden Sie sich an Ihren Verkäufer, Ihre Kundendienststelle oder an qualifizierte 
Fachkräfte.

•	 ÖFFNUNGEN UND MUNDUNGEN: Die Geräte können über Öffnungen verfügen (Belüftung, Schlitze, 
usw.). Niemals Gegenstände in die Öffnungen einführen oder die Öffnungen verschließen. Wenn eine 
Flüssigkeit oder ein Gegenstand in das Gerät gelangt, den Stecker herausziehen und es vor einer neuen 
Inbetriebnahme von qualifiziertem Fachpersonal überprüfen lassen.

SICHERHEITSHINWEISE
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Para  comprender mejor el funcionamiento de este aparato, le recomendamos que le acuidadosamente todas 
las consignas de seguridad y de funcionamiento del aparato antes de usarlo. Conserve las instrucciones de 
seguridad y de funcionamiento para que pueda consultarlas posteriormente. Respete todas las consignas 
indicadas en la documentación, relacionadas con el producto y este documento.

•	 CUIDADO: Para prevenir cualquier riesgo de choque eléctrico y de incendio, no exponga este aparato a 
la lluvia, a la humedad ni a fuentes de calorintensas.

•	 INSTALACIÓN: Cerciórese de que haya una circulación de aire suficiente para evitar cualquier 
sobrecalentamiento al interior del aparato. No coloque el aparato cerca ni sobre una superficie textil que 
pudiera obstruir los orificios de ventilación. No instale el aparato cerca de fuentes de calor como radiador 
o boca de aire caliente, ni en un lugar expuesto a los rayos solares directos o al polvo excesivo, a las 
vibraciones o a los choques mecánicos. Esto podría provocar su mal funcionamiento o un accidente.

•	 ALIMENTACIÓN: Ponga a funcionar el aparato únicamente con la fuente de alimentación que se indica 
en el aparato. Los aparatos deben estar conectados obligatoriamente a una fuente equipada con una 
puesta a tierra eficaz. Por ningún motivo este enlace de tierra deberá ser modificado, cambiado o 
suprimido.

•	 CABLE DE ALIMENTACIÓN: Los equipos incluyan interruptor general de alimentación (Encender I / 
Apagar 0), la puesta en marcha o desconexión se realiza por medio de este interruptor.

	� El cable de alimentación constituye el único medio de desconectar el aparato totalmente de la red eléctrica. 
Para estar seguro de que el aparato no está más alimentado, este cable debe de ser desconectado de la 
toma de corriente. 

	 Aplicar las siguientes consignas: 
	� -	� El material conectado a residencia a la red informática, debe de tener un dispositivo de seccionamiento 

fácilmente accesible que debe de ser incorporado al exterior del aparato.
	 -	 Desconectar el aparato del enchufe mural si no piensa utilizarlo durante varios días.
	 -	 Para desconectar el cable, tire de la clavija. No tire nunca del cable propiamente dicho.
	 -	 El enchufe de alimentación debe estar cerca del aparato y ser de fácil acceso.
	 -	 No deje caer el cable de alimentación ni coloque objetos pesados encima de él.

	� Si el cable de alimentación sufriera algún daño, ponga el aparato inmediatamente fuera de tensión. Es peligroso 
hacer funcionar este aparato con un cable averiado, ya que un cable dañado puede provocar un incendio o un 
choque eléctrico. Verifique el estado del cable de alimentación de vez en cuando. Póngase en contacto con 
su distribuidor o con el servicio de posventa si necesita cambiarlo.

•	 CONEXIONES: Todas las entradas y salidas (excepto la entrada del sector) son de tipo TBTS (Muy Baja 
Tensión de Seguridad) definidas según EN 60950

•	 REPARACIÓN Y MANTENIMIENTO: Por ningún motivo, el usuario deberá tratar de efectuar operaciones 
de reparación, ya que si abre los aparatos retirando el capó o cualquier otra pieza que forma parte de 
las cajas o si destornilla los tornillos aparentes exteriores, existe el riesgo de producirse una explosión, 
choques eléctricos o cualquier otro incidente. Contacte el servicio de posventa, a su distribuidor o dirigirse 
con personal cualificado únicamente.

•	 ABERTURAS Y ORIFICIOS: Los aparatos pueden contener aberturas (aireación, ranuras, etc.). No 
introduzca allí ningún objeto ni obstruya nunca estas aberturas. Si un líquido o un objeto penetra al 
interior del aparato, desconéctelo y hágalo revisar por personal cualificado antes de ponerlo nuevamente 
en servicio.

INSTRUCCIONES DE SEGURIDAD
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1 x OPS300
1 x Power supply cord
2 x DVI male to HD15 female and DVI female cable
1 x HD15 to 5 BNC cable
1 x Ethernet cross cable (for device update)
1 x DB9 to 4 BNC cable + mini-Din 4 (video out)
1 x Set of 3 audio 10 pin screw terminals
1 x RCS - Remote Control Software *
1 x User Manual (PDF version) *
1 x Quick Start Guide (PDF version) *

* Download on our website: www.analogway.com

2-2. UNPACKING AND INSPECTION

2-3. RACKMOUNT INFORMATION

Tabletop mounting: The OPS300 can be used directly on a table, the unit is equipped with 4 handy anti-slip 
rubber feet.

Rack mounting: The OPS300 is compatible with a 19” enclosure. Please follow the instructions below to 
install the device in a 19” rack.

Place the device in your rack. Attach the device to the rack by using 4 screws through the front panel holes 
(screws not included).
Rear fixing is also recommended, in particular for permanent installations. The OPS300 is equipped with drill 
holes designed for compatibility with most rackmount braces. 
Connect all of the cables of the device and attach them to the rack with the help of tie wraps.

IMPORTANT: 
-	� The openings in the side and rear panels of the device are for cooling. Do not cover these openings to 

avoid cutting air circulation.
-	 Be sure that no weight in excess of 2 kg (4.4 Lbs.) is added onto the OPS300.
-	 The maximum ambient operating temperature should not exceed 40°C (104°F).
-	� The rack and all mounted equipment in it must be reliably grounded according to national and/or local 

electrical standards.

Dismantling front handles of the device could invalidate warranty on after sales services of your 
OPS300. It is strongly advised to avoid using front handles as rests for your OPS300, they are 
designed for manipulation purposes only.

If required, front handles of the device can be dismantled, but with caution.The original screws removed 
must not be reintroduced to their location without handles in place. Substancial damages can occur, 
including risk of electric shock from the main voltage. Only M4x12mm screws can be used. They are 
supplied with the unit.

2-4. CABLE AND ADAPTOR INFORMATION

A large choice of cables and adaptors are compatible with the OPS300. To find which are to be used in 
your setup, please refer to the Hardware Specifications chapter. Please contact your distributor for a list of 
available cables and connectors for your OPS300.

!

WARNING !
If required, front handles of the device can be dismantled, 
but with caution.
The original screws removed must not be reintroduced to 
their location without handles in place.
Substantial damages can occur, including risk of elec-
tric shock from the mains voltage.

Only M4x12mm screws can be used.
(They are supplied with the unit)

11



• ANALOG COMPUTER:
Connectors: 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 		
			   Input #8: female HD15.

Line frequency: 	 Up to 130 kHz (165 MHz Max pixel rate).
Resolution: 	 Up to 1600x1200 @ 165Mhz, 1920x1200px 
			   (RB, 	Max V size: 1200px, Max H size 2048px).
Sync. types: 	 RGBHV, RGB/S, RGsB (Sync On Green).
Levels: 		  R, G, B = 0.7 Vp/p.
			   H & V Sync = TTL 
			   Composite Sync = TTL and 0.3 V (negative).
			   SOG (Sync On Green) = 0.3 V.
Impedance: 	 R, G, B = 75 ohms.
			   H = 75 ohms or Hi-Z.
			   V = Hi-Z.

• RGB/S - RGsB VIDEO:
Connectors: 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 		
			   Input #8: female HD15.
Frequency: 	 15.625 kHz - 50 Hz (625 lines).
			   15.734 kHz - 60 Hz (525 lines).
Levels:		  R, G, B = 0.7 Vp/p.
			   SYNC. = 0.3 Vp/p or TTL (negative).
Impedance:	 RGB = 75 ohms.
			   SYNC. = 75 ohms or Hi-Z.

• COMPONENT:
Connectors: 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 		
			   Input #8: female HD15.
Frequency:		 15.625 kHz - 50 Hz (625 lines).
			   15.734 kHz - 60 Hz (525 lines).
Levels:		  Y = 1 Vp/p (0.7 V Luma + 0.3 V Sync.).
			   Cr / Pr & Cb / Pb = 0.7 Vp/p.
Impedance:	 75 ohms.

• HDTV - HD-YUV:
Connectors : 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 
			   Input #8: female HD15.
Formats : 		  720p/576p (60Hz), 1080i (50/60Hz), EDTV.
Levels : 		  Y = 1 Vp/p (0.7 V + sync.).
			   Cr / Pr & Cb / Pb = 1 Vp/p (0.7 V + sync.).
Sync. :		  Tri-level: ±0.3V (positive/negative).
			   Bi-level: 0.3V (negative).
Impedance:	 75 ohms.

2-5. HARDWARE SPECIFICATIONS

Input specifications
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• S.VIDEO:
Connectors: 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 				  
			   Input #8: female HD15 + 4-pin MiniDin.
Standard:		  PAL/SECAM: 15.625 kHz - 50Hz - 625 lines.
			   NTSC (3.58 - 4.43 MHz): 15.734 kHz/60Hz/525 lines.
Levels:		  Y = 1 Vp/p (0.7 V Luma + 0.3 V Sync.). 
			   C = 0.3 Vp/p (Chroma Burst).
Impedance:	 75 ohms.

• COMPOSITE VIDEO:
Connectors: 	 Inputs #1 to #5: female HD15. 
			   Inputs #6 & #7: female DVI-I (analog pins). 
			   Input #8: female HD15 + RCA.
			   Standard:	 PAL / SECAM: 15.625 kHz - 50 Hz - 625 lines.
			   NTSC (3.58 - 4.43 MHz): 15.734 kHz - 60 Hz - 525 lines.
Level:		  1 Vp/p (0.7 V Luma + 0.3 V Sync.).
Impedance:	 75 ohms.

• DVI (Digital Video Interface):
Connector:	 	  DVI Inputs #1 & #2: female DVI-I (digital pins).
Line frequency:	  Up to 130 kHz (165 MHz Max pixel rate).
Format:		   Digital Visual Interface (DVI)-TMDS single link.
Resolution: 	  Up to 1600x1200 @ 165Mhz, 1920x1200px 				  
			    (RB, Max V size: 1200px, Max H size 2048px).

• SD-SDI:
Connector:		 SDI Inputs #1 & #2: female BNC.
Formats:		  SMPE 259M-C
Data rate: 		  270 Mbps serial digital.
Impedance:	 75 ohms.

• HD-SDI:
Connector:		 SDI Inputs #1 to #2: female BNC.
Formats:		  720p @ 50, 59.94 & 60 Hz.
			   1035i @ 50, 59.94 & 60 Hz.
			   1080i @ 50, 59.94 & 60 Hz.
			   1080p @ 23.97, 24, 25, 29.97, 30, 50, 59.94 & 60 Hz.
			   1080sF @ 50, 59.94 & 60 Hz.
Data rate:		  1.54 Gbps serial digital - SMPTE 292M (Level A).
			   2.97 Gbps serial digital - SMPTE 424M (3G-SDI) (Level A).
Impedance:	 75 ohms.

• AUDIO INPUT:
Connectors: 	 Balanced or unbalanced mono/stereo inputs 
			   (or 10-pin MCO male connector or 3,5mm Jack).
			   Inputs #1 & #4: 3,5mm Jack Stereo Connector input
			   (unbalanced connection). 

			 

			   Inputs #5 to #6 and DVI #1 to DVI #2
			   (or 10-pin MCO male connector) (Unbalanced connection).
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• ANALOG OUTPUTS
Connector:	Outputs #1 (Main) & #2 (Preview): female HD15, DVI-I (analog pins).

HDTV Resolutions:

Output specifications

Format Ratio Available Refresh Rates Reduced Blanking
640 x 480 4 : 3 50Hz 60Hz 72Hz 75Hz
800 x 600 4 : 3 50Hz 60Hz 72Hz 75Hz
848 x 480 16 : 9 50Hz 60Hz 72Hz 75Hz
1024 x 768 4 : 3 50Hz 60Hz 72Hz 75Hz
1280 x 720 16 : 9 50Hz 60Hz
1280 x 768 15 : 9 50Hz 60Hz 72Hz 75Hz
1280 x 800 16 : 10 50Hz 60Hz 72Hz 75Hz
1280 x 1024 5 : 4 50Hz 60Hz 72Hz 75Hz
1360 x 768 16 : 9 50Hz 60Hz 72Hz 75Hz
1366 x 768 16 : 9 50Hz 60Hz 72Hz 75Hz
1366 x 800 15 : 9 50Hz 60Hz 72Hz 75Hz
1400 x 1050 4 : 3 50Hz 60Hz 72Hz 75Hz
1440 x 900 16 : 10 50Hz 60Hz 72Hz 75Hz
1600 x 1200 4 : 3 50Hz 60Hz
1680 x 1050 16 : 10 50Hz 60Hz
1920 x 1080 16 : 9 50Hz 60Hz 72Hz 75Hz YES
1920 x 1080 B 16 : 9 50Hz 60Hz YES
1920 x 1080 C 16 : 9 50Hz 60Hz YES
1920 x 1080 HD 16 : 9 50Hz 60Hz YES
1920 x 1200 16 : 10 50Hz 60Hz YES
2048 x 1080 19 : 10 50Hz 60Hz YES
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Signals:		  RGBHV, RGBS and RGsB.
Levels:		  R, G, B = 0.7 Vp/p.
			   Sync.: Separate H & V = TTL (negative).
			   Composite = TTL (negative).
			   SOG = 0.3 Vp/p (negative).
Impedance:	 R, G, B = 75 ohms.

Format Ratio Available Refresh Rates
720p 16 : 9 50Hz 59.94Hz 60Hz
1035i 16 : 10 59.94Hz 60Hz
1080i 16 : 9 50Hz 59.94Hz 60Hz
1080p 16 : 9 30 Hz 50Hz 59.94Hz 60Hz

Resolutions:



• DVI (Digital Video Interface) OUTPUTS

Connector:		 Outputs #1 (Main) & #2 (Preview): female DVI-I (digital pins).

Signal:		  Digital Visual Interface (DVI)-TMDS single link.

HDTV Resolutions:

Format Ratio Refresh Rate Reduced Blanking
640 x 480 4 : 3 50Hz 60Hz 72Hz 75Hz
800 x 600 4 : 3 50Hz 60Hz 72Hz 75Hz
848 x 480 16 : 9 50Hz 60Hz 72Hz 75Hz
1024 x 768 4 : 3 50Hz 60Hz 72Hz 75Hz
1280 x 720 16 : 9 50Hz 60Hz
1280 x 768 15 : 9 50Hz 60Hz 72Hz 75Hz
1280 x 800 16 : 10 50Hz 60Hz 72Hz 75Hz
1280 x 1024 5 : 4 50Hz 60Hz 72Hz 75Hz
1360 x 768 16 : 9 50Hz 60Hz 72Hz 75Hz
1366 x 768 16 : 9 50Hz 60Hz 72Hz 75Hz
1366 x 800 15 : 9 50Hz 60Hz 72Hz 75Hz
1400 x 1050 4 : 3 50Hz 60Hz 72Hz 75Hz
1440 x 900 16 : 10 50Hz 60Hz 72Hz 75Hz
1600 x 1200 4 : 3 50Hz 60Hz
1680 x 1050 16 : 10 50Hz 60Hz
1920 x 1080 16 : 9 50Hz 60Hz 72Hz 75Hz YES
1920 x 1080 B 16 : 9 50Hz 60Hz YES
1920 x 1080 C 16 : 9 50Hz 60Hz YES
1920 x 1080 HD 16 : 9 50Hz 60Hz YES
1920 x 1200 16 : 10 50Hz 60Hz YES
2048 x 1080 19 : 10 50Hz 60Hz YES

• AUDIO OUTPUT

Connector: Output #1 (Main) and #2 (Prelist): 
		  2 Balanced or unbalanced mono/stereo 
		  outputs (on 10-pin MCO male connector).

Vo max: 	 Unbalanced = +15dBu (at 300Ω load).
		  Balanced = +21dBu (at 600Ω load).
		  Zo = 600Ω balanced.
		  Zo = 300Ω unbalanced.
		  G = 0 dB nominal.
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Outputs #1 to #2: Balanced & unbalanced connection
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Format Ratio Available Refresh Rates
720p 16 : 9 50Hz 59.94Hz 60Hz
1035i 16 : 10 59.94Hz 60Hz
1080i 16 : 9 50Hz 59.94Hz 60Hz
1080p 16 : 9 30 Hz 50Hz 59.94Hz 60Hz

Resolutions:



• VIDEO OUT

Connector:		 1 x female BNC
SD-SDI:		  Female BNC.
Formats:		  SMPTE 259M-C.
Data rate	 : 	 270 Mbps serial digital.
Impedance:	 75 ohms.
HD-SDI:		  Female BNC.
Formats:		  720p @ 50, 59.94 & 60 Hz.
			   1035i @ 59.94 & 60 Hz.
			   1080i @ 50, 59.94 & 60 Hz.
			   1080p @ 23.97, 24, 25, 29.97, 30 & 60 Hz.
			   1080sF @ 50, 59.94 & 60 Hz.

Data rate:		  1.54 Gbps serial digital - SMPTE 292M.
			   2.97 Gbps serial digital - SMPTE 424M (3G-SDI).

Connector:		 1 x female DB9
			   (This connection must be used with the cable supplied in the packaging: DB9 to 4 BNC 		
			   cable + mini-4Din).
Formats:		  SDTV PAL & NTSC
Signals:		  Component: Red, green and blue wires
			   S-Video: Mini-4Din (white and black wires)
			   Composite: Grey wire
Impedence: 	 75 ohms
Cable reference for spare part: #10120

• COMMUNICATION PORTS

REMOTE RS232
Connector:		 DB 9 female.
Protocol:		  RS-232.
Data Rate:		�  9600 Bauds, 8 data bits, 1 stop bit, no parity bit, no flow control 

by default. 
			   DTR & RTS needed for upgrade.

• LAN
Connector:		 RJ45.
Protocol:		  TCP (Transmission Control Protocol) or UDP
			   (User Datagram Protocol). 
Ethernet: 		  Base 10/100.

Communication specifications
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The video output generates a SDI signal in which is embedded only one stereo audio stream.

Settings Availability
Gain Yes: from -∞ to +18dB
Balanced Audio Left and Right
Auxiliary Input Mixing Yes
Adjusting Audio Delay Yes: from 0 to 80ms (Automatic or Manual)



Dimensions: 	 W 482 x D 330 x H 88 mm
			   19”W x 13”D x 3.50”H
Weight: 		�  5 kg / 11 lbs
			   (Compatible with a Standard 19” rack, Height = 2 U)

Cooling air flow from right side to left side.

Max ambient operating temperature:	 < 40°C (< 104°F).

Operating temperature: 			   0 to +40°C / +32°F to +104°F

Storage temperature: 				    -40 to +70°C / -40°F to +158°F
	
Operating humidity: 				    10 to 80% (non condensing)

Input voltage range: 				    100-240 VAC, 50/60 Hz

Typical consumption: 				    90 W

CE Compliancy, test following:

		  - EN 55022: 2006 / A1: 2007,
		  - EN 55024: 1998 / A1: 2001 / A2: 2003,
		  - EN 61000-3-2: 2006,
		  - EN 61000-3-3: 1995 / A1: 2001 / A2: 2005.

Safety, test following:

		  - IEC 60950-1: 2005,
		  - UL 60950-1: 2007,
		  - CAN/CSA-C22.2 NO. 60950-1.

Power supply: IEC/EN/UL/CSA 60950-1, internal, autoswitching

Mechanical (in carton): Vibration: IEC60068-2-64

Free fall: IEC60068-2-32, RoHS, WEEE

Environmental specifications
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Pinouts

•	 VGA
STANDARD VGA
1- Red			  6- Red Return			  11- ID Bit 0
2- Green		  7- Green Return		  12- ID Bit 1
3- Blue			  8- Blue Return			  13- H Sync
4- ID Bit 2		  9- No Pin			   14- V Sync
5- Test (Gnd)		  10- Sync Return		  15- ID Bit 3

•	 DIGITAL VISUAL INTERFACE DVI
Pin
1- TMDS Data 2-	   7- DDC Data			  13- Not used			   19- TMDS Data 0 Shield
2- TMDS Data 2+	   8- Analog Vertical Sync	 14- +5V (Power)		  20- Not used
3- TMDS Data 2 Shield  9- TMDS Data 1-		  15- Ground for (+5V)		  21- Not used
4- Not used		   10- TMDS Data 1+		  16- Hot Plug Detect.		  22- TMDS Clock Shield
5- Not used		   11- TMDS Data 1 Shield	 17- TMDS Data 0-		  23- TMDS Clock +
6- DDC Clock		   12- Not used			   18- TMDS Data 0+		  24- TMDS Clock-

C1- Analog Red Video (or Cr/Pr or C)			   C4- Analog Horizontal Sync (or Composite Sync)
C2- Analog Green Video (or Y or Composite Video)		 C5- Analog Common Ground Return
C3- Analog Blue Video (or Cb/Pb)

DDC = Display Data Channel
TMDS = Transition Minimized differential signal

•	 RS-232 CONNECTOR
Pin
1- NC						      6- NC
2- Transmit data to PC (Tx1)			   7- NC
3- Transmit data from PC (Rx1)		  8- NC (or +12V. dc)
4- Receive data from display unit (Rx2)	 9- Transmit data to display unit (Tx2)
5- Ground

•	 S-VIDEO (Y/C) CONNECTOR - 4-pin Mini Din
Pin
1- Y Ground 		  2- C Ground 		  3- Y Signal 		  4- C Signal

•	 VESA DDC (Inputs #1, #2 and #8)
Pin
1- Red			  6- Red Return			  11- ID Bit
2- Green		  7- Green Return		  12- Bi-directional data (SDA)
3- Blue			  8- Blue Return			  13- H Sync 
4- ID Bit 2 0		  9- DDC+5 Volt supply		 14- V Sync
5- Test			  10- Sync Return 	 	 15- Data Clock (SCL)

•	 Video Out (SD/HDTV) (Specific Wiring)
Pin
1 Ground (red, green, blue, composite)
2
3 Red (R-Y)

4 Green (Y)

5 Blue (B-Y)

6 Y (S.VIDEO)

7 COMPOSITE VIDEO

8 Ground (Y+C)

9 C (S.VIDEO)

18



If you want to use HDCP content from your sources, be sure pluging HDCP compliant screens or projectors. 
If it’s not the case, the output image could be disabled.
When displaying HDCP protected sources on non HDCP compliant equipment, the following message will be 
displayed on the device VFD screen:

“Due to HDCP content, non HDCP screens cannot display protected sources”

Your screen will go to black without displaying the HDCP input image, or partially layer out non HDCP content.

Concerning the DVI inputs, a specific feature allows enable/disable the HDCP receiver for the input chosen.

It can be very useful especially when using a Mac:

Input Menu > DVI# > HDCP detection

The output status can provides you all information about the output in real time.

This feature is particularly needed when HDCP is used with long cable to be sure that the communication is 
well handled.

To summarize all HDCP status, please see in the Control Menu --> HDCP Summary.

HDCP compliance

NOTE: as part of our policy of continuous improvement, Analog Way reserves the right to make 
design and specification changes for product improvements without prior notice. The performance 
specification figures indicated are nominal values of production units. There may be some deviations 
from these values in individual units.

!
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3-1. CONNECTING THE OPS300

The OPS300 can be set up with up to 12 different sources, and will drive up to 2 digital DVI-D sources, 2 SD-
SDI sources and 8 analog computer/video sources simultaneously. The versatility of the OPS300 will allow 
for almost any event configuration and cater for all your projection needs.

The intuitive rear panel of the OPS300 will let you set up for the first time quickly and easily. Here is an 
example of a typical OPS300 setup.

CONNECTING THE OPS300
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The OPS300 rear panel is equipped with 11 universal digital and analog inputs. Inputs #1 through #5 (3) are 
universal analog inputs. Inputs #6 & #7 share a DVI-D signal and a universal analog signal (plug the shipped 
Analog Way DVI/HD15 adaptor cable to use DVI-D and analog signals  simultaneously).

The Main and Preview (6) outputs will allow for the OPS300 high resolution digital and analog signals to be 
viewed on screen and/or on a preview monitor (see also Output Specifications in this chapter). 

The extra Video Out card installed on the OPS300, can be used for recording, broadcasting or previewing 
purposes in a wide range of formats for maximum compatibility with industry viewing or recording equipment. 
Finally, the audio in and output card will let users trigger audio with any source, accurately balance or tweak 
sound sources and outputs.
 

1 : AC outlet and ON/OFF switch
2 : IP-LAN connector
3 : Universal Analog inputs
4 : DVI-I Input (DVI-D + Analog)
5 : HD-SDI inputs
6 : Main and Preview outputs
7 : SD-HD/SDI output
8 : SD/HDTV output
9 : Audio inputs
10 : Audio outputs
11 : RS232 connector

Overview

3-2. THE OPS300 REAR PANEL
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UNIVERSAL COMPUTER & VIDEO INPUTS
Universal Inputs accept computer sources (RGBHV, RGBS, 
and RGsB (SOG) signals), standard TV/VIDEO sources 
(Composite video, S.VIDEO), Component video (YUV, RGBS 
& RGsB (SOG)), and HDTV sources (480p, 720p & 1080i).
HD15: 1 x Universal Analog input on female HD15 connector.

COMPUTER SOURCES:
The device accepts the following computer signals: RGBHV, 
RGB/S, and RGsB on inputs #1 to #8.

COMPOSITE VIDEO SOURCES:
The Composite Video signal, usually called COMPOSITE or 
VIDEO, is available on most video equipment (VCR, DVD, 
CAMCORDER…), but is also the lowest in picture quality. 
The video standard of this signal can be NTSC, PAL or 
SECAM. The signal is transmitted on a single coaxial cable, 
and is connected to the video equipment with an HD15 
connector. 

For inputs #1 to #5: connect a 1 x BNC from your composite 
source, to the HD15 input of the device. 

For input #8: connect 1 x BNC from your composite source, 
to the composite RCA input of the device. 

S.VIDEO SOURCES:
The S.VIDEO signal, also called Y/C, HI-8™, or S.VHS™, is 
available on DVD players and high quality VCRs (S.VHS). 
The S.VIDEO signal in which the Luminance (Y) and 
Chrominance (C) information are separately transmitted, 
gives a higher quality picture than the Composite video 
signal. The S.VIDEO connector is usually a 4-pin Mini-DIN 
connector also called Oshiden™ connector.

For inputs #1 to #5: connect a 2 x BNC from your S.VIDEO, 
Y (G/Y) & C (R/R-Y), to the HD15 input of the device. 

For input #8: connect a 2 x BNC from your S.VIDEO, Y (G/Y) 
& C (R/R-Y), to a 4-pin mini DIN cable, or to the HD15 input 
of the device. 

Inputs #1 to #8

G

Composite Source

GR

S.Video Source

Analog Computer Sources
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COMPONENT VIDEO SOURCES:
The Component Video signal, also called YUV (Y, Pr, Pb) 
or BETACAM™ is widely used in broadcasting and is 
available on high-quality DVD players. The COMPONENT 
signal is transmitted with 3 coaxial cables, and also has 
a better quality picture than COMPOSITE and S.VIDEO 
signals. The COMPONENT connectors are usually RCA 
(x3), or BNC (x3).For inputs #5 to #8: connect a HD15 to 
3 x BNC cable between the HD15 connector of the device 
and your Component source.

RGBS VIDEO SOURCES:
This signal is widely used in broadcasting and is available 
on European DVD player. The RGB/S signal is transmitted 
with 4 coaxial cables, and also has a better picture quality 
than COMPOSITE and S.VIDEO signals. The RGB/S 
connectors are usually BNC connectors for Broadcasting 
equipment, and SCART connector for DVD players.
For inputs #1 to #5 and #8: connect a HD15 to 4 x BNC 
cable between the HD15 connector of the device and your 
RGB/S source.

PREVIEW OUTPUT:
ANALOG:			   1 x analog output for the main display 
				    device on female  HD15 connector.

DIGITAL/ANALOG:	 1 x main output on female DVI-I 
				    connector (simultaneous analog and 		
				    digital).

DVI AND ANALOG SOURCES:
DVI Inputs #1- #2 on the OPS300 accept up to 2 live sources 		
			   in Digital format.
DVI-I:			  1 x digital (DVI) and 1 x analog input on 			
			   female DVI-I universal connector.

SD/HD-SDI SOURCES:
SD/HD-SDI Inputs #1- #2 on the OPS300 accept up to 2 live 		
				    sources in Digital formats.
SD/HD-SDI:		  1 x digital input on female  BNC connector.

G B SR

RGBS Source

DVI Inputs #1 - #2

Digital & Analog Computer Sources

D
V

I-D

SD/HD-SDI Inputs #1 - #2

Preview Outputs
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MAIN OUTPUT:

ANALOG:	 1x analog output for the main display device on female  HD15 
connector.

DIGITAL/ANALOG: 1x main output on female DVI-I connector	
(simultaneous analog and digital).

VIDEO OUTPUT:

Video Output card provides SD or HDTV formats in various signals and 
connectors from Composite Video to HD SDI. This output can be used to 
record your show by outputting the same content as the Main output in Mixer 
Mode, or a choice between output #1 or #2 in Matrix Mode (see also OPS300 
Modes, p.4).

AUDIO SWITCHER:

Audio Stereo Switcher card features 12 inputs and 2 outputs. An additional 
auxiliary input can be mixed with any other input. Master Volume and 
individual input level can be adjusted. Each input and output offers balanced 
or unbalanced connections. It should be noted that the management of the 
audio output follows the selection of video layers. Two modes are available: 
Top Follow or Breakaway. In Top Follow Mode, the audio follows the topmost 
video layer (after having pressed [TAKE]). In Breakaway Mode, it is the 
selected audio layer input that is permanently diffused.

Main Outputs
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The highly intuitive front panel of the OPS300 was designed by Analog Way engineers to simply and quickly 
meet all of your event needs. Within minutes, you will be able to enjoy its full potential and easily parameter 
most of its functions, without having to be an expert audio-visual engineer, leaving room for what is most 
important to our users: concentrating on their event.

The OPS300 front panel is comprised of several sections, each carefully labelled and self explanatory, 
corresponding to all the machine’s versatile functions. 

	   1 : Standby button
	   2 : Menu screen
	   3 : Menu scroll knob
	   4 : Control section
	   5 : Layer Selection section
	   6 : Input Selection section
	   7 : Freeze button
	   8 : Audio-Video input 8
	   9 : Take button
	 10 : T-Bar
	 11 : Effect selection button
	 12 : Preset selection button

OPERATING THE OPS300

4-1. THE OPS300 FRONT PANEL

Overview
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On/Off button

The [STANDBY] button allows users to put the OPS300 into sleep 
mode, and startup again. The [STANDBY] button does not replace 
the ON/OFF switch at the rear of the unit, and is implemented 
essentially for ease-of-use in rackmount situations.
--> Hold for 3 seconds for stand-by mode

Menu screen

The Menu Screen of the OPS300 is the visual interface to your 
OPS300 menu. It gives users a constant indication of available menu 
options, parameters of any selected object, system information, and 
everything you need to know to control the device.

Menu scroll knob

The Menu scroll knob allows users to quickly scroll through menu 
items and increase or decrease any modifiable value in the OPS300 
menu. Simply scroll to the desired menu item, and press the [ENTER] 
button to confirm your choice.

Control section

The [EXIT/MENU] and the [ENTER] button in the Control section of 
the OPS300, allow users to respectively enter and exit the OPS300 
menu, and confirm selected menu items.
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Layer selection section

The Layer Selection section allows to select which type of layer to 
work with:

•	 Background Frame �(non-positionable, non-resizable static back-
ground),

•	 Background Live �(positionable, resizable animated background), 
•	 PIP (positionable, sizable floating window),  
•	 Logo (positionable, key sensitive layer).

Take button

The OPS300 [TAKE] button allows to switch from Preview to Main 
outputs. By pressing the [TAKE] button, what you have setup on your 
preview screen will be transitioned to the Main output display.



The handy front panel Audio-Video Input 8 lets users quickly access 
an extra universal analog input source, without the hastle of re-
cabling the OPS300 rear panel, or for quick source changes during 
a show or presentation.

Freeze button

Audio-Video input 8

The [FREEZE] button of the OPS300 allows users to freeze the 
Main output current display or the active input, depending on the 
freeze mode: FREEZE ALL or freeze the current selected input 
INPUT FREEZE.

Input selection section

The Input Selection section allows to select 
which input (#1 to #12) to display in a selected 
layer. Select one of 12 simultaneous inputs, (8 
analog inputs, 2 DVI-D inputs, 2 SDI inputs) by 
simply pressing one of the Input buttons.

The [BLACK] button allows users to remove layer content on screen.
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The OPS300 T-Bar allows to switch from Preview to Main outputs 
manually, and as gradually as you wish. By sliding the T-Bar, what 
you have setup on your preview screen will go live on the Main 
output display at the same speed as you slide it.

T-Bar

Effect selection button

The OPS300 [EFFECT] selection button is the shortcut to the current 
layer.

Preset selection button

The OPS300 [PRESET] selection button allows you to instantly 
recall a saved preset.
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To access the OPS300 menu, press the [EXIT/MENU] button in the control section (4). To highlight items in 
the menu which will appear on the VFD screen (2), turn the scroll knob (3) left or right to the desired menu 
item. When you have reached the desired menu item, press the [ENTER] button in the control section (4) to 
access that menu function. Pressing the [ENTER] button when a selection has been made sets the value to 
that selection in the OPS300 memory. When all settings have been made, press the [EXIT/MENU] button to 
exit sub-menus and return to the main menu.

* IMPORTANT * : simply selecting a menu item will not set it to that value. Be sure to press the [ENTER] 
button when parametering the menu items.

4-2. THE OPS300 MENU

Menu navigation

Home menu

Pressing the [MENU] button in the menu section of the OPS300, will display and give you access to the 
following items on the menu VFD screen: 

- �MODE: select to choose which mode the OPS300 will work (in Mixer or Matrix see OPS300 Modes p.4).
- INPUT: select to configure the 12 individual input types and resolutions.
- MAIN OUT: in Mixer Mode, select to set the output types and resolutions of the Main output.
- OUTPUT 1: in Matrix Mode, select to set the output types and resolutions of Output 1.
- PREVIEW OUT: in Mixer Mode, select to set the output types and resolutions of the Preview output.
- OUTPUT 2: in Matrix Mode, select to set the output types and resolutions of Output 2.
- VIDEO OUT: select to configure Video output card settings.
- PRESET: select to store and use presets.
- IMAGE: select to change source image settings of an input.
- KEYING/TITLING: select to access keying and titling controls and parameters when video layer is selected.
- LAYER: select to adjust layer size, position, border, transparency or transitions.
- LOGO/FRAME: select to store (record) and manage logos and frames into the OPS300.
- AUDIO: select to access all audio input and output parameters.
- CONTROL: select to access device software information, LAN settings, reset factory settings, amongst 	
  other user oriented functions.

2 3

41
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4-3. WORKING WITH THE OPS300

Operating modes

The OPS300 offers 2 modes to work from: the Mixer Mode, which is the OPS300 default mode and the Matrix 
Mode, which turns your OPS300 into a true 12 x 2 scaled matrix with numerous effects.

* NOTE * : the OPS300 will only let you work on your preview screen (direct access to main screen is locked).  
In Matrix mode, the OPS300 loses the use of layers, PIPs and logos.

To choose which mode the OPS300 will work in, press the [EXIT/MENU] button and select Mode in the menu 
by rotating the scroll knob. Then press the [ENTER] button to enter the Mode sub-menu. Select the desired 
mode by rotating the scroll knob, and press the [ENTER] button to confirm your choice. Press the [EXIT/
MENU] button to return to the main menu.

Reseting default values

It is strongly recommended resetting all of the default values of your OPS300 unit before setting up your 
shows and events. To do so, press the [EXIT/MENU] button and select Control in the menu by rotating the 
corresponding knob. Then press the [ENTER] button to enter the Control sub-menu. Select Default Values 
by rotating the scroll knob, and press the [ENTER] button to enter your choice to restart your OPS300 with its 
factory settings. This operation should take approximately 30 seconds.

OPS300 color codes

Analog Way engineers have developed a handy, user friendly way of identifying machine status on the front 
panel, via the use of color codes on the buttons of the machine. All new Analog Way machines use the same 
codes, for quick recognition of the status of any device of the range, at any given time.

For the OPS300, button color codes are as follow:

-	 Sources on the Main output are indicated in red when active,
-	 Sources on the Preview output are indicated in green when active,
-	� Buttons in the layer section turn red or green, depending on whether the selected layer is active in 

respectively the Main or Preview window,
-	 Menu buttons are indicated in green,
-	� Selecting a button with an available source or function will cause that button to blink green on the 

preview, or red once it is on the Main output,
-	 TAKE button reacts as follows: 

•	 	If take function is available, the button will appear in green. 
•	 When the take function is active, it will light up red.

#1 = Source, Layer or Window is on Main	
#2 = Freeze enable
			 
#1 = Source or Layer is on Preview	
#2 = �Function available for modification
#3 = Current output on Matrix Mode

Button available for selection

Active Layer or Source for modification on Main

Active Layer or Source for modification on Preview

Stand-by button

Solid red:

Solid green:

Dim green:  

Blinking red: 

Blinking green: 

Dim red:
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To set up your inputs:
Input menu → Auto settings

You can also do it manually on each input# using the [ENTER] and the Knob button and set up the inputs 
type one by one.

You can also check your actual input configuration using the config status:

Input menu → Config Status

You can find several settings for each input (some settings are specific to some signal type):
	 -	 Type: to set up your input type (Computer, Video etc..)
	 -	 Enabled/disabled: to enable/disable input#
	 -	 Audio input: to set up the audio regarding the input 
	 -	 H sync. load: to change the load of the Sync. signal (Hi-Z, 75 ohms)
	 -	 EDID: to set up the EDID in terms of resolution and rate 
	 -	 Status: to summarize the input status

Concerning the DVI inputs, a specific feature allows enable/disable the HDCP receiver for the input chosen. 
It can be very useful especially using a Mac:

Input menu → DVI # → HDCP detection

* NOTE * : the input status is available at any time in status input menu and can give you information about 
format rate and HDCP.

If you have any trouble to detect source, please check the Input status and see if the unit is receiving a source 
or not.

Input selection settings

Source Input selection

Plug your sources thanks to the 8 universal inputs, 2 DVI-I Inputs or 2 SDI inputs.
Don’t forget that the 2 DVI-I inputs can be used with DVI-D computer sources (DVI#1 & DVI#2) but also with 
a DVI-I adaptor for analog sources too (source #5 & #6) shipped with your unit.

Be sure that all connectors are firmly attached using all available locking screws.

A- SETTINGS IN MIXER MODE

Input Sync. Loss Function

The Input Sync. Loss function allows to display a source in case of sync loss of the selected input. To set up 
the Sync. Loss function:

Menu → Control → Sync. Loss → Press Input# 
The selected input must be activated to be visible in case of sync loss.
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Output selection settings

To set up the output, go in the Main Output or Preview Output menu and choose first the adapted format/
resolution, and then the appropriate rate for your screens by using the knob button and the [ENTER] button.

Main Output → Output Format → Output rate

Use the native resolution of your screens/projectors in order to obtain the best image quality. In the Preview 
Output menu, you can also match the output configuration the Main Output to the Preview Output by checking  
the case Sync w/Out 1. It allows you to set up your outputs via the output 1 menu.

Preview output → Sync w/Out 1

Some other settings are available too:
-	 Output sync. polarity. 
-	 Gamma: use this feature to set up the output Gamma.
-	 Flicker Filter (Video Out only): apply a flicker filter on your video output.
-	 Analog type: set up the type of synchronisation of your Analog output.
-	 DVI type: set up the type of color space of your Digital output.
-	 HDCP detection: set up to enable/disable the HDCP detection on the output.
-	 Background color: add a background color in place of the default black one.
-	� Test pattern: use test pattern on Main or Preview screen to configure your projectors.
*All changes have to be validated by pressing the [ENTER] button in order to be saved*

Source output selection

Once your inputs all have been configured, the output settings of the OPS300 must be set according to the 
machines plugged on your OPS300 main and preview outputs (video projector, preview monitor...).

* NOTE *:  if you want to use HDCP content from your sources, be sure to attach HDCP compliant screens 
or projectors. If it’s not the case, the output image could be disabled.

* NOTE *: the output status can provide you all information about the output in real time. This feature is 
particularly needed when HDCP is used with long cable to be sure that the communication is well handled.

Video Out

The Video Out allows you the same settings as other outputs with some additional specific options:

-	 Sharpness: set up the sharpness on the video out image.
-	 Flicker Filter: apply a flicker filter on your video output to eliminate flickering.
-	 Under/Over Scan: perform an automatic zoom on the output.
- 	 Adjust: allow you to setup the video out image in H, V position and H, V size.
-	 Connection: allow you to choose between several output pattern.

In Matrix mode, the menu “Connection Mode” appears. It allows you to choose recording Output #1 or #2.

The Output menu also allows you to generate test patterns. The test patterns  are available through the 
Output menu and let you quickly and reliably setup your projectors.
	� 1.	 In the menu section, press the [EXIT/MENU] button and select Output in the menu by rotating the 

corresponding knob. Then press the [ENTER] button to enter the Output sub-menu.
	� 2.	 In the Output sub-menu, select the Test Pattern menu, then select the output (Main or Preview) 

on which you want the test pattern to appear by rotating the scroll knob. Press the [ENTER] button 
to enter the Test Pattern menu. Choose the test pattern you wish to use in the Test Pattern menu by 
rotating the scroll knob, and press [ENTER]. The chosen test pattern will immediately appear on the 
selected screen(s).

	 3.	 Press the [EXIT/MENU] button twice to return to the main menu.

* NOTE *: be sure to turn the test pattern off to display your sources again.
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To attach a source to a layer, press the Layer button, press the Source# you want to attach.

Ex: [BACKGROUND LIVE ]→ Source #4
The source number 4 will be displayed in the Background live. 

Press [TAKE] to view the result on the Main screen.

To delete a Layer from the Preview screen:
Press Layers # → Press [BLACK] button 

Press [TAKE] to view the result on the Main screen.

To delete every Layers on your Preview screen:
Hold the [BLACK] button briefly

Press [TAKE] to view the result on the Main screen.

To freeze a layer:		  Select a Layer → Press [FREEZE] button

Working with Layers

Working with Layers Functions

Once a source is attached to a layer, you will have access to some layer settings in the Layer menu or directly 
by pressing the layer button.

The settings available depend on the layer selected:

-	 Layer adjusts: set up layer size and position.
-	 Layer zoom: set up layer zoom size and position.
-	 Size Template: set up your layer in predefined size template.
-	 Transparency: adjust the Layer transparency.
-	 Border: choose the border and adjust its properties.
-	 Opening and Closing effect: adjust the Open/Close effect type and duration.
-	 Smooth move: enable/disable smooth move.
-	 Status: get the selected layer status.

*All changes have to be validated by pressing the [OK] button in order to be saved*

Press [TAKE] to view the result on the main screen.

Settings available:

Settings Background Live / PIP#1 PIP#2 PIP#3
Position YES YES YES
Size YES YES YES
Zoom YES YES YES
Transparency YES YES YES
Border YES YES YES
Opening effects YES YES YES
Closing effects YES YES YES
Smooth Move YES YES YES
H Flip / V Flip NO NO NO
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Even the Logo and Frame buttons can access to their own settings, but a source # has to be affected too.

The Main output can displayed simultaneously up to 6 layers stacked from bottom to top as follows:

-	 The Background Frame: One stored frame selected from 8 available,
-	 The Background Live/ PIP#1: One source selected from 12 inputs available,
-	 The PIP#2: One source selected from 12 inputs available,
-	 The PIP#3: One source selected from 12 inputs available,
-	 The Logo#1: One stored Logo selected from 8 available,
-	 The Logo#2: One stored Logo selected from 8 available.

Opening transitions and closing Live Layers

When transitioning live  layers, depending on how many scalers are in use, the OPS300 [TAKE] function will act in 
one of 3 different ways when transitioning the Next Preset (Preview) to the Current Preset (Main):

• TAKE 1- shot: Case #1

- There are enough scalers for making a transition
- All inputs are locked on to scalers
- There are no contraints for closing before the [TAKE]
- All opening and closing transitions can be performed simultaneously.

• TAKE 2- shot: Case #2

- There are enough scalers for making a transition
- All inputs are locked on to scalers before the [TAKE]
- There are no constraints for closing during the [TAKE]
- �All the necessary closing transitions are performed to free occupied scalers and then the OPS300 performs all 
openings.

• TAKE sequenced- shot: Case #3

- There are not enough scalers for making a transition
- All inputs are not locked on to scalers
- �All the necessary closing transitions are performed to free occupied scalers. The OPS300 locks on to new 
sources and performs all openings.

Working with PIPs

A PIP is used as a layer. Please report to WORKING WITH LAYERS section.

1 PIP + Live Background 2 PIPs + Live Background 3 PIPs + Still Background
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PIP adjustment menu

To have access to the PIP adjustment menu, a source has to be affected to your PIP:
Press PIP#  button → Press source #

Once a source is attached to PIP, you can have access to the PIP adjustment Menu:
Press PIP # button

Press [TAKE] to view the result on the main screen.

PIPs with Transitions & Borders

Transitions:
All the settings are available in the Layer Menu after pressing the selected PIP.
The transition effects have a shortcut on the front panel too.  
To Use it:	 Press the selected layer ([Background Live], [PIP #1] or [PIP #2]) → Press the [EFFECT] button

The effect will be immediately attached to the selected PIP.
Concerning the User 1 and User 2 button, they have to be set up before in the Control Menu-->Prog. Keys

PIPs as Layers

PIP configuration

All the settings and shortcuts available for layers are available for PIPs. Please refer to “Working with Layer” 
and “Working on Layer functions” sections.

A PIP is considered as a layer and has the same properties. All of the same manipulations are possible.

Fade
Wipe

Slide

- Numerous wipes can be selected horizontal and vertical, from 
the center or outside, in circle, Zoom in and out

- Horizontal: from left, center -or- vertical: from up, down, center, 
or corner

- Sliding of video or computer images during the transition

- Horizontal: from/to left, -or- vertical: from/to up, down

- Adjustable pre-timed fades or manual 
transition with T-Bar
- Fade between any input, computer or video
- Adjustable cross-fading duration

& corner ‘A’ comes back on Preview if 
the Preset Toggle function is 
activated.
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Border:
The border has to be setting up in the Layer Menu:

Press PIP# button → go in border menu → select and set your border with colour and size
Press Take to view the result on the main screen.

No border Color border

The OPS300 offers a wide variety of transitions between the scenes you create for your shows and events. It 
allows for live recall of 4 user presets, each of which you can edit at any given time.

1.	 Whether catering for complex event  setups, or putting together intricate shows, your OPS300 will 
also deliver some of what you could expect from a dedicated mixer, along with its switcher and scaler 
capabilities.

2.	 In the Layer Selection section, press the [PIP1] button. The button will start blinking. On your Preview 
screen, [PIP1] will appear as a color rectangle. The parameters of the layer will automatically appear on 
your OPS300 VFD menu screen.

3.	 In the Layer Menu, make the position, size, border and transparency settings you like, then select Opening 
Effect in the layer options, press the [ENTER] button and select Type. Select Slide Left - Right for example, 
and press the [ENTER] button to confirm. Navigate to Duration in the Opening Effect sub-menu, and set 
the duration of your effect by rotating the SCROLL knob and pressing [ENTER].

Repeat the procedure in the Closing Effect sub-menu to determine the way your layer will close. Try Slide 
From Left - Right for the closing type with a duration of 1.5 seconds for example.

Layer transitions & effects
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Working with Frames

Opening transitions & closing Still Layers (Logos or Frames)

It is possible to store up to 8 frames in the OPS300 non volatile memory. Frames are mainly used 
as backgrounds in a typical show or event setup, and can be recorded from any of the OPS300’  
12 sources and called back at the press of a single button. To use a frame, be sure first that it is well saved, 
then:

Press [BACKGROUND FRAME] button → Press the source button (#1 to #12) of the source 
memorized  → Press the [TAKE] button to display

* NOTE * : �Frames may be used only one at a time and can be placed only in the background Frame layer.

When transitioning still layers, depending on how many scalers are in use, the OPS300 [TAKE] function will 
act in one of 2 different ways when transitioning the Next Preset (Preview) to the Current Preset (Main):

• TAKE shot: #1 

- All still frames make an opening and closing phase.
- �All sources of the same layer are completely different between the Current Preset and the Next Preset. The 

opening and closing effects of the Layer are set to Cut.

• TAKE shot: #2

- One of the Layer makes a change of source which be not in Cut.
- The opening and closing phases can be done with different effects.
- �The still frame appears and disappears of the layer with the following effects: Cut, Fade, Slide or Wipe.

Capturing still Frames

To capture a frame, display the exact content you want to save on one of your outputs, at the exact resolution, 
you can use the [FREEZE] button if you want. Then follow this step:

Logos/Frames menu → record Frame menu→ Frame #

Choose the frame number slot and wait until the unit to finish saving. Your frame is now saved and you can 
use it through the [BACKGROUND FRAME] button.

The capture of frames can be done only under the following conditions:

	 - 	 the unit can be in Mixer Mode,
	 -	 the capture can be done the Main output or the Preview output,
	 - 	 the disappearance of frames on the Preview and Main output is normal.

A frame captures the state of the specified output at the main output resolution, and must be recalled using the same 
output resolution. Resizing or other image manipulation of the captured frame is not possible.

Attempting to use a Frame at a different resolution will result in a partial Frame display or a Frame which does not fill 
the step.

The captured output is outlined by a white border and includes the pixels beneath the white border.

The Frame/Logo can be memorized from Output #1 or #2. To record a Frame/Logo, please refer to the chap-
ter “Capturing still Frame/Logo” in the Mixer mode.

To use a Frame/Logo, refer to “Working with Frame/Logo”.

As a source, each frame/logo can be used by both outputs, you just have to select the correct matrix# button first.
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Frames as Layer

The background frame is considered as a layer and has some settings available:
Transparency, Opening/Closing effect, Smooth move and Status.

Those settings have to be used as Layer settings.
Press [BACKGROUND FRAME] button to have access to the Layer menu settings.

You can change frame or delete frame on the preview screen using the same way the layers do:
Delete: Press [BACKGROUND FRAME] button → Press [BLACK]

Change: Press [BACKGROUND FRAME] button → Press another Frame #
Press [TAKE] to view the result on the main screen.

Frame setup menu

In the frame setup menu, you have the possibility to save a frame, and the possibility to erase a stored frame:
Logos/Frames menu → save Frame → Frame #

Logos/Frames menu → Erase → Frame #



38

Capturing Logos

To capture a Logo, display the exact content you want to save on the main screen, you can use the [FREEZE] 
button if you want. Then follow these steps:

Logos/Frames menu → Record Logo menu → Set up your logo → Store menu → logo# 

To set up your logo you have several features available:

-	 Position / Size Adjustment
-	 Keying type
-	 Luma / Chroma key
-	 Cut out color.

Select the logo number you want to save and wait until the unit finish saving. Your logo is now saved and you 
can use it through the background logo button.

You can save up to 8 logos with the OPS300.

The capture of logos can be done only with the following conditions:

-	 The unit can be in Mixer Mode or Matrix Mode,
-	 The capture can be done on the Main output or the Preview output (selected source),
- 	 The disappearance of logos on the Preview and Main output is normal.

The logos are captured with the same size as is visible on the Main output without any form of adjustments. 
If zooming is required resize the PIP or use the layer or input zoom. 

A logo captures the state of the defined area on the specified output at the Main output resolution, and must 
be recalled using the same output resolution. Resizing or other image manipulation of the captured logo is 
not possible.

The capture zone is outlined by a white rectangle and includes the pixels beneath the white border. The non-
captured area is reduced in brightness.

Logo capture is limited in the number of pixels being captured. When the logo capture area is resized, 
extending the horizontal size may reduce the vertical size to compensate.

Logos can also be captured and displayed with transparent areas. By adjusting the keyer in the logo capture 
menu, the portions of the captured area can be keyed away and captured as transparent.

The menu “Cut out color” can help display which portions of the image will be captured as tranparent.

* NOTE *: The cut out color is only a visual tool to help identify the transparent areas of the logo. These 
colored regions will not be captured but later displayed as transparent area.

* NOTE *: Capturing a “Logo” is limited to a small percentage of the output resolution. To capture and 
display a full screen image, use the still “Frame”.
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Logos setup menu

In the Logos/Frames menu, the logos can be deleted in the Erase menu:

Logos/Frames menu → Erase menu → Select Logo#

Memorizing logos in the OPS300

1.	 In the Input Selection section, press the source button (#1 to #12) of the source you wish to record as a 
logo. The source button will start blinking.

2.	 Select the Logos/Frames menu by scrolling through the menu with the scroll knob, then pressing the 
[ENTER] button.

3.	 Select Record Logos in the Logos/Frames  menu by rotating the scroll knob, then pressing [ENTER]. A 
small white rectangle will appear on your main display, indicating the logo that will be captured.

4.	 Adjust logo size, position, and fine tune key attributes by rotating the scroll knob and pressing [ENTER] 
to memorize logo settings.

5.	 Select an empty logo memory (empty logos are indicated in the sub-menu) to store the logo into. Press 
the [ENTER] button. The OPS300 will display a progress status bar on the VFD screen.

Logos as Layer

Logos are under the Layer rules, you will have direct access to settings by pressing the Logo Layer button.
You have 2 logos layer buttons available. 

You can use the Pos/Size/Zoom adjustment button and the [EFFECT] button from the front panel too.

Working with Logos

A Logo can be manipulated through the front panel. On the front panel, the logo# are associated to the input# 
respectively. To assign a logo# to the logo layer:

Press [LOGO] Layer button → Press Input#

Logos #1 to #6 are available directly by the input # button on the front panel. For logo #7 and #8, you have to 
use shift button first:

Press [LOGO#1] Layer button → Press Shift button → Press Input#
(For logo #7 or #8 use Shift then Input # button)

You can change logos or delete logos on the preview screen using the same way the layers do:
Clear: Press [LOGO (#1 or #2)] button → Press [BLACK]

Change: Press [LOGO(#1 or #2)] button → Press another Input#
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Working with Audio

Working with Preset Layouts

The OPS300 allows to work with up to 10 stereo inputs, 1 auxiliary input, and 2 stereo embedded SDI audio 
inputs (via the SDI BNC connectors), all accessible via the Audio menu of the OPS300, and which can be 
assigned to one or both of the 2 independant symetrical/asymetrical outputs of the device.

On the OPS300, a list of pre-saved preset layouts can be recalled at any time:

1.	 Go in the “Preset Menu” and choose “Preset Layouts”

2.	� Now you have access to a list of 12 layouts. Select the desired pattern and press OK to apply this 
pattern to your current preview.

3.	 Press [TAKE] to see the result on the main output.

Creating Presets

The OPS300 allows the creation of user defined presets very easily. Any setup you have configured on 
screen, can be stored into one of the 4 available user presets.

1.	 After having configured Layers, PIP transitions, logos... on your screen (see ‘Working with the OPS300’), 
go to the Preset menu by pressing the [EXIT/MENU] button, and select Preset by rotating the scroll knob. 
Then, press the [ENTER] button to enter the Preset sub-menu. Choose Preset Copy by scrolling with the 
corresponding knob, and press the [ENTER] button to access the sub-menu.

2.	 In the sub-menu, choose Save From Main or Save From Preview to determine which screen you want to 
memorize the preset from, then set the preset memory (#1 to #4) you wish to use as your “User Preset” 
(by default, the OPS300 will choose the next available preset in the OPS300 memory). 

3.	 By pressing the [ENTER] button, the OPS300 will ask you to confirm. Select Yes, your screen is memorized 
as a preset.

In Mixer Mode: In the preset Menu, some already existing preset are available in the preset layout menu.
Choose your layout with associated PIPs and TAKE it to the main to see the result.
You can at any time memorize those presets in one of the preset memory buttons.

Working with Presets

The four user presets of the OPS300 can be recalled at any stage during your show or event.

1.	 Press the [PRESET] button, then press one of the four first Input Selection section buttons to choose which 
memory (#1 to #4) you wish to use. The preset will be displayed on your preview screen.

2.	 Once you have selected your preset, simply press the [TAKE] button to view the result on your main 
screen.
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Special Features

Dynamic Fit (automatically activates the Transparent Background)

- Dynamic & Automatic adjustment of the PIP to fit the source image borders (Black Stripe).

- Automatic adjustment of the PIP (Ratio) to fit the source image borders during a transition.

PIP

To configure audio settings of the OPS300, plug all audio inputs into the device, and navigate to the Audio 
menu.

1.	 Choose the Audio mode, Break Away or Top Layer Follow, which you wish the audio to work in.

* NOTE * : the Break Away mode will route the selected audio source, while the Top Layer Follow mode will 
route audio from the topmost active layer of the OPS300.

2.	 Select Source Settings from the Audio Menu to select the audio source you wish to work with, then set 
levels and left/right balance for each input.

3.	 �Select Auxiliary Settings to determine level and balance of the auxiliary input. 
* NOTE * : the auxiliary input is combined with the currently selected input.

4.	 In Mixer Mode, select the Main Output Menu to determine main audio output level, balance and delay 
settings, or to mute main audio output.

* NOTE * : in Matrix Mode, all output parameters can be assigned separately to outputs #1 and #2.

5.	 In Mixer Mode, select Audio Prelist, from the Audio menu, to determine pre-listen audio output level, 
balance and delay settings, for each audio input, or to mute Prelist audio output.

* NOTE * :  in Matrix Mode, select Out1 Prelist or Out2 Prelist from the Audio menu to set audio pre-listen 
output parameters.

6.	 Select Delay Mode, to determine how the OPS300 deals with audio delay. Select Auto Adjust to let the 
OPS300 determine audio output delay. Select Manual Adjust to determine audio delay manually.

* NOTE  * : selecting Manual Adjust will give access to audio delay value (in milliseconds) of the Main and 
Prelist audio output Menus.

Audio configuration
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Smooth Move effect

- Smooth Move PIP control the acceleration of the PIP. The time can be different between the opening and 
closing PIP.

Transparent Background

- Transparent Background allows you to remove the black band on sources in the background live layer in 
order to display behind a background frame or background color.

Background Frame

Image Live

- The function disables all the display of information in Preview Mode. The colorful frames and numbers 
with the same color are disable. To set up your Preview Id:

Menu → Control → Preview Id

Preview ID
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To use Keying, first select a source in the desired layer:

Layer button --> source number button

Then in the main menu, select the Keying/Titling menu.

You now have several choices to key your sources. The Luma Key and the Chroma Key based on the Luma 
pixel values and the Chroma pixel values and for both an additional Titling menu which can be useful to 
choose the transparency value of your keying.

Keying/Titling menu -> Type menu -> Select your keying type

Once your keying mode is selected, the OPS300 provides you some keying advance setting:

For Luma Key: 

	� Luma Keying is used to key from a particular luminous intensity.  It produces a hard edged key based 
on intensity, which is most suitable for titling effects. You can choose to key things that are extremely 
dark or extremely bright and keep everything in between, or invert to key only things that are of a me-
dium intensity. 

	� The black and white levels define where to begin the keying.  In the range 0 to 255, 0 represents no 
luminance, or black and 255 represents full luminance, or white.  

	 - �Level Black: As the Black Level is changed from 0 to 255, things that are black are first keyed out, 
followed by dark grey, then light grey, and so forth, until the entire picture is keyed out at 255.

	 - �Level White: As the White Level is changed from 255 to 0, things that are white are first keyed out, 
followed by light grey, then dark grey, and so forth, until the entire picture is keyed out at 0.

Working with DSK (Chroma / Luma key)

- �OPS300 allows to use a live source with green or blue (or any color) background and to key it over another 
live input.

- Background is removed and replaced by another source.
- Title can be keyed (DSK) on Analog or Digital Sources.

+ =>

White levelBlack level

Keyed Away Keyed AwayVisible Picture

Non-Inverted Mode
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For Chroma Key:

Chroma Keying is used to key from a particular color. It produces a soft-edged key which is most suitable for 
moving images and “weatherman” style applications.  

Color grabber:
Select Chroma Key menu -> Select Color grabber menu

Using a crosshair, you can select a particular hue based on what is on screen. Once you have adjusted the 
crosshairs to a desired position, press set/enter to capture the color value at that instant.  You can then adjust 
the other parameters such as Tolerance to further refine your key.

Manual Setting:

Select Chroma Key menu -> Manual Settings menu

	 R,G,B:
	� These controls allow you to manually select a hue, defined by its Red, Green, and Blue values as you 

can find in Windows (Paint software).

	 Tolerance:
	� The Tolerance parameter allows you to expand your key color selection to include colors which are 

similar to the selected value. A tolerance of 1 will select only the desired hue, whereas a tolerance of 
255 will select nearly all hues.

	 Black Level:
	� This option permits adjustment of the luminance levels of the keyed hue. The Black Level is the lumi-

nance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level 
but darker than the White Level will be considered part of the key.

	 White Level:
	� This option permits adjustment of the luminance levels of the keyed hue. The White Level is the lumi-

nance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level 
but darker than the White Level will be considered part of the key.

Titling alpha:
If you have selected one of the two Titling mode, the titling menu appears.
This option places a transparent black backdrop behind the entire layer to which the key is applied.  This 
effect is useful for using bright titles on bright backgrounds, such as clouds. 

Invert keying:
By default, this mode is disabled. When this mode is activated, the key selection will remain on screen, and 
all other portions of the image will be keyed away. For example, you would see the green screen behind the 
actor, while the actor would be keyed away.



OPS300 Motion Correction

This item gives information about the new “Motion correction” setting added in the OPS300 device.

- Aim of the “Motion Correction” setting:
The aim of the “motion correction” setting is to correct a “comb effect” sometime visible on OPS300 device. 
From the front panel, a new setting has been added in the Menu/Image/Advanced section.

- Typical case:
The “comb effect” appears only with moving interlaced input pictures, with 
vertical scaling, more with medium contrasted images and mainly with inter-
laced output format.

The default value of this setting is 0 for standard motion correction, and can be increased up to 100 for full-
motion correction.
The correct level must be adjusted according to the image, preferably not at maximum, in the following 
examples around 80 or 90.

- Examples:
Here is an example of a worst case scenario, using an analog HD-YUV input signal from an HD camera run-
ning in 1080i 50Hz, split in two layers side by side (with and without correction), displayed in interlaced 1080i 
50Hz frame locked on the input, with a few scaling.

The camera is panning over a medium contrasted scene as viewed here:

This panned scene is viewed here:

Another typical case is viewed here:
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From the Menu select the following Aspect options.
Select first the Aspect In then Adjust the Aspect Out.

Aspect In
Provides aspect ratio adjustments for the content of the image. Affects the raster size of content provided to 
the signal processing chain.

NATIVE *
No adjustment.

LETTER BOX 1.78
Adds black bars to image to create a 1.78 image from a 4:3 signal. Useful when you have 16:9 content that 
appears correctly in the correct aspect ratio when viewed within a 4:3 format (ie. 1.78 letterboxed DVD).

LETTER BOX 2.35
Adds black bars to image to create a 2.35 image from a 4:3 signal. Useful when you have 2.35 content that 
appears correctly in the correct aspect ratio when viewed within a 4:3 format (ie. 2.35 letterboxed DVD).

PILLAR BOX
Adds black bars on sides to create a 4:3 image from a 16:9 signal. Useful when you have 4:3 content with 
black bars on the sides in a 16:9 signal.

ANAMORPHIC
Adds black bars to image to create a 1.78 image from a 4:3 signal, and stretches horizontally, while compres-
sing image vertically to fit. Useful when you have 16:9 content that is horizontally squashed when viewed 
within a 4:3 signal (ie. anamorphic wide screen DVD).

Aspect Out
Provides aspect ratio adjustments for frame in which the image will be displayed.

1:1
No scaling or resizing of any kind is done. Aspect ratio preserved. 

CENTERED
The image is scaled until it fits vertically or horizontally, whichever keeps the entire image visible. Aspect ratio 
preserved, but black bars will be added if necessary.

FULL SCREEN *
The image fits Horizontally and Vertically of the incoming raster ot the output raster. This will compromised 
the aspect ratio.

CROPPED
The image is scaled until it fits vertically or horizontally, whichever eliminates all black bars. Aspect ratio pre-
served, but some content will be cropped out of the raster (offscreen).

* default settings

OPS300 Aspect Ratio
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From the Image Menu

The Force to 4/3 capability allows you to give a 4/3 aspect Ratio to a SDTV Input, this allows you to keep 
the ratio of a PAL input (ie) shown on a SDTV PAL Output.

The image will be scaled to fit a 4/3 aspect Ratio.
The Force to 4/3 setting will not affect an image in a «Fullscreen» aspect Out.

The Force to 4/3 setting will react as an Image Setting (will be recalled each time the input is shown).

PAL
Input

NTSC
Input

768

640

4/3

4/3

576

480

5/4

3/2

720

720

768

640

4/3

4/3

576

480

576

480

sampling Force to 4/3

OPS300 Force to 4/3
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In the Control Menu, you will find all setup which cannot be classified in the image, layer, input or output 
menu.

Version:			   it indicates the actual software version of the OPS300.
				    it can help if you need to contact our technical support team.

RS232/LAN:		  choose your connection type when controling by a R.C.S or an external program.

LAN SETUP:		  in this menu, you can adjust every settings reluted in the network

HDCP Summary:	 show all HDCP Inputs/Outputs Status

Sync. Loss:		  see p.30

Auto Lock:	 	 enable/disable the source selection when no-synch are detected

Auto Take:			  allow the unit to take by itself as soon as it detects a change (source, layer, position...)

Preset Toggle:		  enable this feature to put you last program on your preview after a TAKE

UT Bar:			   enable/disable the virtual T-Bar (it will appear in the Main Preview)

Transparent Bkngd:	 see p.42

Dynamic Fit:		  see p.41

Preview Id:	 	 see p.42

Freeze mode:		  choose between 2 modes: Single Layer Freeze Mode or All Layers Freeze Mode

Key Locking: 		  enable to lock a part or all your front panel

LCD Brightness:	 adjust the LCD Brightness

Key Brightness:		 adjust the Key Brightness

Standby:			   parameters for the standby mode

Layer parameters:	 allow you to reset at the original size/position all layers

Erase Memories:	 erase all image settings: blanckings, colors...

Default values:	 	 put every internal values to factory default (except Ethernet values).

Using the Control Menu
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Input selection settings

Source Input selection

Source output selection

Same as MIXER Mode.

Same as MIXER Mode.

Same as MIXER Mode.

* NOTE *: if you want to use HDCP content from your sources, be sure to plug HDCP compliant screens or 
projectors. If it’s not the case, the output image could be disabled.

B- SETTINGS IN NATIVE MATRIX MODE

Output selection settings

To set up the outputs, go in the Output #1 or Output #2 menu and choose first the appropriate format/reso-
lution and then the adapted rate for your screens by using the knob button and the [ENTER] button.

Output# → Output Format → Output rate

You can also in the Output #2 menu, synchronise all the changes from the Output #1 to the Output  #2 by 
checking the case Synch w/Out 1. It allows you to set up both outputs at the same time.

Output #2 → Synch w/Out 1

Try to use the native resolution of your screens/projectors in order to obtain the best image quality.

* NOTE *: The output status can provide you all information about the output in real time. This feature is 
particularly needed when HDCP is used thanks to the HDCP status.

*All changes have to be validated by pressing the [OK] button in order to be saved*
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Display Mode Presentation Availability

Output #1

YES

YES

OUT #1

Output #2

OUT #2

Menu→ Video Out → Connection → 
Output #1

Menu→ Video Out → Connection → 
Output #2

Working with Layers

Same as MIXER Mode.

Settings Background Live & Frame 
(Output #1 & Output #2)

Position NO
Size NO
Zoom YES
Transparency YES
Border NO
Opening effects YES
Closing effects YES
Smooth move YES
H Flip / V Flip NO

Video Out

In Native Matrix mode, the menu “connection mode” allows you to choose recording Output #1 or Output #2.
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Press Matrix #2 button → Press Background live button → Press input #3
Press [TAKE] to view the result on both screens 

Don’t forget to press the correct Matrix # button before pressing the Layer selection button, in order to be sure 
doing the manipulation on the correct output.

Working with Cut, Fade or Transitions

All the transitions (Cut, Fade or Transitions) are available in the Native Matrix Mode. Although the Matrix 
Mode is activated, you will be able to perform powerful transition effects seamlessly.

1 background live on each output → 2 scalers used → 2 seamless transitions

The background Frame and the Logos are not considered as live layers and are not counted as using a scaler.

Working with Native Matrix Mode

To activate the Native Matrix Mode:

Mode Menu  → Native Matrix mode menu
You’ll find all menus from the Mixer Mode in the main menu except some specific matrix function added.

To work with Native Matrix Mode, you have to use the Matrix # buttons first.
For instance, if you want to put the Frame #1 on the Output #1 and the Live source #3 on the output #2:

Press Matrix #1 button → Press Background Frame button → Press input #1

Output selection settings

	� Same as Mixer Mode (Preview is replaced by output #2 in this case)

Working with Frames

Same as Mixer Mode

Same as Mixer Mode.

Capturing Still Frames



52

Same as Mixer Mode.

Same as Mixer Mode.

Same as Mixer Mode.

Capturing logos

Memorizing logos

Working with logos

Same as Mixer Mode.

Layer transitions & effects

Creating Presets

Same as Mixer Mode.

Working with Presets

Same as Mixer Mode

Working with Audio

Same as Mixer Mode

Same as Mixer Mode

Audio configuration
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HOME MENU

[MAIN]
 Format : 1920 x 1080
 Rate : 50Hz
 Lock : internal

                   MAIN      PREVIEW
 ---------+----------------+-------------
 Logo2  |  Logo #2    |  Logo #8
 Logo1  |  Logo #1    | Logo #7
 Pip2     |  SDI 2        | SDI 1
 Pip1     |  DVI 1        | DVI 2
 Live      |  Input 1      | Input 8
 Frame  | Frame 1      | Frame 8

MATRIX MODE

[OUT 1]

[OUT 2]

 Format : 1920 x 1080

 Format : 1920 x 1080

 Rate : 50Hz

 Rate : 50Hz

 Lock : internal

 Lock : internal

    |    OUT 1    |  OUT 2 
 ---------+--------------+----------
 Live      |  Input 1    |  SDI 2

MIXER MODE



54

 Mixer Mode
 Matrix Mode

 Config status

 Autoset all

 Synchronized

 Input 1 Analog
 Input 2 Analog
 Input 3 Analog
 Input 4 Analog
 Input 5 Analog
 Input 6 Analog
 Input 7 Analog
 Input 8 Analog
 DVI 1
 DVI 2
 SDI 1
 SDI 2

(i1) displayed when plug is not SDI
(i2) displayed when type is analog video
(i3) displayed when plug is analog
(i4) displayed for input ln1, ln2, ln8, DVI1 
& DVI2

 Type (i11)

 Analog group 1
 Analog group 2
 Analog group 3

 Audio input

 Enabled

 Autoset (L1)

 H sync load (i3)

 VCR Mode

 HDCP Enable (i10)

 EDID (i4)

 Status

(i10) displayed when plug is not DVI-D
(i11) displayed when plug is analog

 SDTV Composite (i11)

 Input 1

 Input 4

 None

 SDTV Y/C (i11)

 Input 2

 Input 5

 Input 7

 Audio Input 1 

 SD/ED/HD RGBS (i11)

 Input 3

 Input 6

 Input 8

 Audio Input 2

 SD/ED/HD RGsB (i11)

 Audio Input 3

 SD/ED/HD YUV (i11)

 Audio Input 4

 Computer SOG (i11)

 Audio Input 5

 Computer HV/C (i11)

 Audio Input 6

 Computer RW (i11)

 Audio DVI 1

 Computer 0-255 (i10)

 Audio DVI 2

 Computer 16-235 (i10)

 Audio SDI 1

 DVI video RGB (i10)

 Audio SDI 2

 DVI video YUV (i10)

 Hi-Z
 75 Ohms

 Edit EDID

 Auto
 NTSC
 PAL
 PAL_M

 Left

 640x480
 852x480

 1280x720

 1280x768

 1200x800

 1440x900

 1364x1024

 1680x1050

 2048x1080

 1920x1200

 Right

 800x600

 1024x768

 1360x768

 1366x800

 1280x1024

 1400x1050

 1920x1080

 1600x1200

 1280x960

 Group A - Ch 1

 Group A - Ch 4

 Group B - Ch 3

 Group C - Ch 2

 Group D - Ch 2

 72Hz

 Group A - Ch 2

 Group B - Ch 1

 Group B - Ch 4

 Group C - Ch 3

 Group D - Ch 3

 75Hz

 Group A - Ch 3

 Group B - Ch 2

 Group C - Ch 1

 Group D - Ch 1

 60Hz

 Group C - Ch 4

 50Hz

 85Hz

MODE

INPUT

 Group D - Ch 4
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 Output format

 Output rate

Out Sync Polarity

Gamma

Flicker filter (o4)

Analog Type

Bkgd Color

DVI Type

Test Pattern

HDCP Detection

 640x480		  4/3

 23.97 Hz (o2)

 848x480		  16/9

 25 Hz (o2)

 1280x720		  16/9

 30 Hz (o2)

 1280x800		  16/10

 59.94 Hz (o2)

 1360x768		  16/9

 72 Hz (o2)

 H-, V+

 Follow x 1/2

 RGBS

 Hue

 RGB full (0-255)

 1400x1050	 4/3

 Frame lock from

 H+, V+

 Follow x 3

 YUV

 luma

 YUV

 Automatic

 1600x1200	 4/3

 1920x1080	 16/9

 1920x1080	 B
 1920x1080	 HD

 800x600		  4/3

 24 Hz (o2)

 1024x768		  4/3

 29.97 Hz (o2)

 1280x768		  15/9

 50 Hz (o2)

 1280x1024	 5/4

 60 Hz (o2)

 H-, V-

 Internal ref

 RGB HV

 Predefined color

 1366x800		  15/9

 75 Hz (o2)

 H+, V-

 Follow x 1
 Follow x 2

 RGsB (SOG)

 Saturation

 RGB       (16-235)

 Disabled

 1440x900		  16/10

 1680x1050	 16/10

 1920x1200	 16/9
 1920x1080	 C

 2048x1080	 19/10

 Input 1 Analog
 Input 2 Analog
 Input 3 Analog
 Input 4 Analog

 OFF

 Input 5 Analog

 V Grey scale

 Input 6 Analog

 H Grey scale

 Input 7 Analog

 V Color bar

 Input 8 Analog

 H Color bar

 DVI 1

 Grid

 DVI 2

 SMPTE

 SDI 1

 Burst (o3)

 SDI 2
 Video out

 Centering

 MAIN OUT (A1)  Sync w/OUT 1 (o1)

Output status

 OUTPUT  1 (A2)

 PREVIEW OUT (A1)

 OUTPUT 2 (A2)
 (o1) only for Preview out/Output2
 (o2) depending on output format
 (o3) computer & HDTV only
 (o4) Interlaced output only

 (A1) displayed in Mixer & Quadravision Mode
 (A2) displayed in Matrix Mode
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Connection

Output status

Output format

 Preview/Output 2

 SDTV NTSC

 EDTV 576p

 HDTV 1035i

 HDTV 1080p
 HDTV 1080 sF

 Main/Output 1

 SDTV PAL

 EDTV 480p

 HDTV 720p

 HDTV 1080i

 (o1) available in near future
 (o2) according to output format

 (p1) available only on Matrix Mode
 (p2) available only on Matrix Mode

 VIDEO OUT

Flicker Filter

Under/Overscan

Test Pattern

Gamma

Sharpness

Pos/Size adjust

 OFF
 V Grey scale
 H Grey scale
 V Color bar
 H Color bar
 Grid

 Both Outputs

 SMPTE

 Current Output

 Burst (o3)

 Output 1

 Centering

 Output 2

Output rate  23.97 Hz (o2)

 25 Hz (o2)

 30 Hz (o2)

 H Pos

 60 Hz (o2)

 V Size

 50 Hz (o2)

 V Pos

 24 Hz (o2)

 29.97 Hz (o2)

 59.94 Hz (o2)

 H Size

 PRESET LAYOUT

Step Back

Preset mgmt (p1)

Save Preset

Load Preset

 Save from

 Save from

 Save to

 Save to

 Memory 1

 Memory 1

 Main

 Main

 Preview

 Preview

 Memory 2

 Memory 2

 Memory 3

 Memory 3

 Memory 4

 Memory 4

Preset Layouts (p2)
 Default
 Bkgnd + TL Pip
 Bkgnd + TR Pip
 Bkgnd + BL Pip
 Bkgnd + BR Pip

 2 Pip V split
 2 Pip H split

 1L + 2 H split
 1R + 2 H split
 1T + 2 V split
 1B + 2 V split
 3 H Pip
 3 diag Pip
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 IMAGE (A3) Auto Centering (R1)

Blanking Adjust (R2)

Cropping (R2)

Optimize (R1)

Under/Over (R3)

Aspect IN

Aspect OUT

Colorimetry

 H position

 H position

 V position

 V position

 H size

 H size

 Phase

 Underscan	

 Native

 LetterBox_2_35

 Centered

 Contrast

 Pillar Box	

 1-1	

 Hue (R6)	

 V size...

 V size...

 H Total

 Overscan

 LetterBox_1_78

 Full screen

 Brightness

 Anamorphic

 Cropped

 Color

 (R1) Analog Computer Input
 (R2) Analog Input
 (R3) Video Input
 (R4) EDTV/HDTV Input
 (R5) RGB or YUV or YC or CV
 (R6) NTSC Input
 (R7) Interlaced 50 Hz
 (R8) Interlaced 60 Hz
 (R9) SDTV
(R10) Analog input or interlaced signal
(R11) Interlaced signal

 (t1) only displayed for Type = Luma Key or LumaKey+Titling
 (t2) only displayed for Type = Chroma Key or ChromaKey+Titling
 (t3) only displayed for Type = LumaKey +Titling or ChromaKey+Titling
 (t4) only displayed for Type = different from

 (A3) displayed when an input 	
	 is active

KEYING/TITLING (A4)  Type

Lumakey (t1)

Chromakey (t2)

Titling alpha (t3)

Invert keying (t4)

 None

 Chromakey

 Chromakey+Titling	

 Level White	

 Level White	

 Color grabber	

 Manual setting	

 Lumakey

 Lumakey+Titling

 Level Black

 Level Black

 Red key

 H position

 Green key

 V position

 Blue key

 Tolerance

 Tolerance

 Level Black
 Level White

Advanced (R10)  Component Level (R2)

 Motion Correct.(R11)

 Red Level (R5)

 Green Level (R5)

 Blue Level (R5)

2:2 Pulldown (R7)

3:2 Pulldown (R8)

Reset settings
Force 4:3 (R9)
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LAYER (A3) Layer adjust (b1)

Smooth Move

Status

 H Pos
 V Pos	
 HV Pos	

 H Pos	

 HV Size (b2)

 V Pos

 H Size (b2)	

 H Size

 V Size (b2)	

 V Size 

 Style 

 Adjust

 Type

 Duration

 Direction

 Direction

 Duration

 None	

 H Size	

 Clean Cut (b3)

 Clean Cut (b3)

 Top to Bottom (b4)	

 Top to Bottom (b4)	

 From Bottom Left Corner (b4) 

 To Bottom Left Corner (b4) 

 Transparency	

 Right to Left (b4)	

 Right to Left (b4)	

 Slide 

 Slide 

 Horizontal from Center (b5)	

 Horizontal to Center (b5)	

 From Top Left Corner (b4)

 To Top Left Corner (b4)

 From Top Right Corner (b4)

 To Top Right Corner (b4)

 Edge	

 Left to Right (b4)	

 Left to Right (b4)	

 Fade 

 Fade 

 Vertical from Center (b5)	

 Vertical to Center (b5)	

 From Bottom Right Corner (b4) 

 To Bottom Right Corner (b4) 

 HV From Center (b5

 HV to Center (b5

 (b1) Not available for Background Frame & Live
 (b2) Not available for Logos
 (b3) Not available for Frames & logos 

Layer zoom (b3)

Transparency

Border (b3)

Opening effect  Type

Closing effect

 Cut	

 Cut	

 V Size	

 Color	

 Bottom to Top (b4) 	

 Bottom to Top (b4) 	

 Wipe

 Wipe

Size templates (b3)  Full Screen
 3/4 Full Screen	
 2/3 Full Screen	
 1/2 Full Screen
 1/3 Full Screen
 1/4 Full Screen
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Record Logos

Erase  Frame 1 (lf3)

 Frame 4 (lf3)

 Frame 8 (lf3)

 Logo 2 (lf3)

 Frame 3 (lf3)

 Frame 7 (lf3)

 Logo 1 (lf3)

 Logo 8 (lf3)

 Position / Size Adjust

 Keying type

 Luma key (lf4)

 Chroma key (lf4)

 Cut out color (lf5)

 Store

 H pos

 None

 Logo 1

 V pos

 Luma

 Logo 2

 H size

 Chroma

 Logo 3 (empty) (lf2)

 Level black

 Color Grabber

 Logo 5 (empty) (lf2)

 Cut out black

 Logo 7 (empty) (lf2)

 V size

 Logo 4 (empty) (lf2)

 Level white

 Manual setting

 Logo 6 (empty) (lf2)

 Cut out white

 Logo 8

LOGO/FRAME Record Frames  Frame 1

 Frame 3

 Frame 5 (Empty) (lf1)

 Frame 2 (Empty) (lf1)

 Frame 4

 Frame 6 (Empty) (lf1)

 Frame 8

 (lf1) Empty if slot is free for a Frame
 (lf2) Empty if slot is free for a logo
 (lf3) Displays only list of valid Frames and Logos
 (lf4) Displays only for animated Logo
 (lf5) Displays according to keying type chosen

 Frame 7

AUDIO

Aux. setting

Audio Main (m1)

Audio Out 1 (m2)

Audio Out 2 (m2)

OUT1 Prelist (m2)

OUT2 Prelist (m2)

 Breack away

 Input 1

 Input 1
 None

 Input 3

 Input 3

 Input 5

 Input 5

 Input 7

 Input 7

 DVI 1

 DVI 1

 SDI 1

 SDI 1

 Stereo

 TopLayer follow

 Input 2

 Input 2

 Input 4

 Input 4

 Input 6

 Input 6

 Input 8

 Input 8

 DVI 2

 DVI 2

 Master Volume

 SDI 2

 SDI 2

 Audio Delay

 Source  Level

 Balance

 Balance

 Balance

 (m1) Available only on Mixer Mode
 (m2) Available only on Matrix Mode

 Level

Mode

Source settings

 Level

 Master Mute

 H Position

 Red Key

 V Position

 Greeen Key

 Tolerance

 Blue key

 Level Black

 Tolerance

 Level White

 Level White

  Level Black
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Audio Prelist (m1)

Delay Mode

 Input 1
 None

 Input 3

 Input 5

 Input 7

 DVI 1

 SDI 1

 Input 2

 Input 4

 Input 6

 Input 8

 DVI 2

 SDI 2

 Source

 Aux. Mute

 Audio Delay

 Auto Adjust
 Manual Adjust

 Master Mute

 Master Volume

 Stereo

 Balance
 Level

Versions

Key locking

LCD brightness

Key brightness

Standby

Reset Layers

Erase Memories (L3)

Default values  (L3)

 Vers.: 0.42 BETA

 Enabled

 l3=xxxx     l4=xxxx

 Input 2 (L3)

 MM K=xxxx

 Input 4 (L3)

 Remote address (L1)

 CA V=xxxx

 Input 6 (L3)

 Device port...

 TH V=xxxx

 Input 8 (L3)

 Set message ON

 SDI 1 (L3)

 Clear message OFF

 RS232

 TCP

 Netmask...

 l1=xxxx     l2=xxxx

 Input 1 (L3)

 0=xxxx

 Input 3 (L3)

 Device address...

 MF K=xxxx

 Input 5 (L3)

 Gateway address...

 FA V=xxxx

 Input 7 (L3)

 Baud rate

 DVI 2 (L3)

 Clear message ON

 Remote port (L1)

 CS V=xxxx

 DVI 1 (L3)

 Set message OFF

 SDI 2 (L3)

 Standby

 LAN

 UDP

 Input freeze

 All

 Freeze all

 Menus

 Default setup (L2)

CONTROL

RS232/LAN

LAN setup

Sync. loss

Auto TAKE

Auto LOCK

Preset Toggle

TBar enable

Transp. Backgr

Dynamic Fit

Preview ID

Freeze mode

 (L1) UDP only
 (L2) Confirmation asked
 (L3) Only for User 1 & User 2
 (L4) Visible if Sync. Loss is activated
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5-1. THE OPS300 RCS

RCS presentation

The RCS is a powerful tool to exploit all the features of your OPS300 at distance. By LAN or RS-232, you will 
be able to do exactly the same manipulations as you could do from the front panel. User-Friendly and easy-
to-use, you will very quickly be able to manipulate the RCS tool.

REMOTE CONTROL SOFTWARE

How to use the RCS ?

You have to install the software on a Computer and have a LAN board or RS-232 link to use the RCS. After 
the installation, launch the program and proceed to the network establishment.

Software installation

1.	 Connect you on www.analogway.com.

2.	 In the menu, select [Technical Support] menu, then click on [Remote Control Software], select the name 
of your device and click on [Download].

3.	 Click on [Open with] or [Register the file], select the .exe file.

4.	 Follow the Windows installation instructions.
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The RCS software for your OPS300 can be viewed as the software version of the OPS300 front panel menu 
section. It allows you to quickly access all of the OPS300 functions via a single page interface, and easily edit 
your settings directly from your laptop or PC.

Before starting with the RCS software, you must establish a connection from your laptop to the OPS300 you 
wish to run.

The RCS software for your OPS300 is composed of several easily identified sections. 
The tabs menu (1) allows you to navigate through the equivalent of the OPS300 front panel menu items (see 
also “The OPS300 Menu” p.28). 
The green window of the RCS (2) represents your Preview window and can be used to parameter sources, 
frames, layers and logos directly by clicking on the corresponding button, then navigating through the different 
available tabs. The red window of the RCS (3) represents your Main window, and can also be used much like 
the front panel of the OPS300. Create user presets directly in the RCS main window, by clicking on one of 
the four available Preset icons (4) and setting up your preset in the Preview window. 
Clear unwanted steps with the clear button (5), reload a fresh copy of your screen via the Reload Main 
button (6), make smooth takes directly with your mouse or trackpad with the virtual T-bar (7). The Take 
button (9) will allow you to view any changes made to your preview screen on your main screen, Analog Way 
engineers have even implemented a Stepback button (8) to quickly return to your previous setup in case of a 
manipulation error (recall of Preset before Take). 
The status section (10) allows for easy monitoring of the connection status.

Software overview

1

2
3

4

5

6

7

8

10

9
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Serial connection

1.	 Connect a RS-232 cable between the 
OPS300 and your PC, then power on your 
devices.

2.	 Click on the RCS program file on your PC to 
run the software.

3.	 Click on the “Connections” tab and select 
RS-232 as the connection type. In the drop-
down menu, select the COM port number 
corresponding to the connected device 
(default is Port Com 1).

4.	 Click apply, and wait for devices to 
synchronize. The RCS will display the following connection message: “Device Connected”.

5.	 Click on the “Connections” tab to return to the main screen.

Ethernet connection

1.	 Connect a crossed RJ45 cable between the OPS300 and your PC, then power on your devices. Use a  
straight RJ45 cable if connecting through a network switcher.

2.	 Click on the RCS program file on your PC to run the software.

3.	 Click on the “Connections” tab and select LAN as the connection type.

4.	 In the “Remote Address” field, enter the IP address of the OPS300 you wish to control (see also “Working 
with the OPS300”).

5.	 In the “Remote Port” field, enter the remote port number of the OPS300 you wish to control (see also 
“Working with the OPS300”, p. 29).

6.	 Click Apply, and wait for devices to synchronize. The RCS will display a connection message.

7.	 Click on the “Connections” tab to return to the main screen.
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5-2. WORKING WITH THE RCS

Operating Mode

To choose the operating mode you want your 
OPS300 to work in, simply click the “Mode” tab, 
then select the desired mode by clicking on one 
of the two mode buttons (Mixer or Sync Matrix).

* NOTE * : for further details on different modes, 
restrictions and settings, please refer to the 
“Working with the OPS300” chapter, p.29, and 
the “Home Menu” chapter, p.28.

Source input configuration

Once your OPS300 is wired up to your PC, the 
first step in properly configuring your machine is 
to individually select and parameter your inputs.

1.	 Click on the “Inputs” tab of the RCS.

2.	 In the Plug column of the “Input” page, select 
the plug type by clicking the appropriate 
field.

3.	 Activate the input in the Enabled column if it 
is not.

4.	 In the scroll-down menu of the Type column, 
select the signal type connected to that plug.

5.	 Repeat steps 2 to 4 for all sources connected 
to the rear panel of your OPS300.

6.	 Click on the “Inputs” tab to return to the main screen.

* NOTE * : autosetting mode allows an easy setup of sources. Sometimes problems might appears with 
analog or HDCP sources.
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Source output configuration

1.	 Click on the “Outputs” tab of the RCS.

2.	 Select the type of plug which is connected to 
outputs #1 & #2 of your OPS300 by clicking 
in the appropriate field in Analog Type or DVI 
Type for both Main and Preview outputs.

3.	 Select the appropriate output format and 
output rate.

4.	 Click on the “Outputs” tab to return to the 
main screen.

The Output menu also allows you to 
generate test patterns. The test patterns 
available through the Output menu let you 
quickly and reliably setup your projectors.

* NOTE * : be sure to turn the test pattern off to display your sources again.

Working with PIPs

The OPS300 allows users to manipulate 2 PIPs (Picture In Picture) which you can move, size, crop or zoom, 
apply transparency or transitions to.



66

PIP configuration

1.	 Click on the Image tab of the RCS interface. 
The empty Image screen will appear on 
screen.

2.	 By clicking on the drop-down menu 
in the Preview section, situated 
next to the layer you wish to use 
as a PIP, you will access the image 
parameters of the PIP source you select  
(#1 to #12)

3.	 Set the desired PIP attributes (size, 
position, zoom, border, transparency...).

4.	 Click on the Image tab to return to the main 
screen.

Working with Frames

It is possible to store up to 8 frames in the 
OPS300 non volatile memory. Frames are 
mainly used as backgrounds in a typical show 
or event setup, and can be recorded from any 
of the 8 OPS300 sources and called back at 
the click of a single button. 

* NOTE * : to memorize a frame, select an 
input, and take it to the Main screen. Once the 
frame is displayed on your Main output, it is 
then possible to store it to the OPS300 non 
volatile memory.

* NOTE * : frames may be used only one at 
a time. A frame may not be used as a Live 
Background.
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Memorizing Frames

1.	 In the Input Selection section, click on the 
[SOURCE] button (#1 to #12) of the source 
you wish to record as a frame. 

2.	 Click on the Logos/Frames tab of the RCS 
interface. Then click on the [RECORD 
FRAME] button.

3.	 Click on the field next to the first free Frame 
to select it.

4.	 Click on the [ENTER] button.

Working with Logos

It is possible to store up to 8 logos in the OPS300 non volatile memory. Logos work in much the same way 
as frames, and can be recorded from any of the OPS300’ 12 sources. 

Logos have more attributes than frames. They can be sized, positionned, but also keyed via color cutout 
selection or Luma Key.

Memorizing Logos 

1.	 In the Input Selection section, click on the 
source button (#1 to #12) of the source 
you wish to record as a logo. 

2.	 In the Logos/Frames tab, click on Record 
Logo, then select an empty logo memory 
slot (#1 to #8) to record your logo into.

3.	 Adjust position, size and keying attributes 
for your logo.

4.	 Click Execute to record your logo into the 
selected memory slot. The OPS300 RCS 
will display a progress bar while recording 
the logo.

5.	 In the Input Selection section, click the 
LOGO1 button, and select logo number (#1 to #8) you wish to use. Your logo will appear on the preview 
screen above any existing layer on screen.

6.	 Click the [TAKE] button. Your logo will appear on the main display.
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The OPS300 offers a wide variety of transitions 
between the scenes you create for your shows 
and events. It allows for live recall of 4 user 
presets, each of which you can edit at any given 
time.

1.	 In the Layer Selection section, click on the 
[PIP1] button. On your Preview screen, 
PIP1 will appear as a color rectangle. The 
parameters of the layer will automatically 
appear in the RCS Preview section.

2.	 At the bottom of the Preview section, click on 
the Transition tab, then select the transition 
type from the left dropdown menu, and the 
effect behaviour from the right dropdown 
menu.

3.	 Determine effect duration by sliding the duration bar left (shorter) or right (longer), or by manually setting 
the value in the duration value box.

4.	 Repeat the procedure in the Closing Effect tab to determine the way your layer will close.

Layer transitions & effects

Creating Presets

The OPS300 allows the creation of user 
defined presets very easily. Any setup you have 
configured on screen, can be stored into one of 
the 4 available user presets.

1.	 After having configured layers, PIP 
transitions, logos... on your screen (see 
“Working with the RCS” chapter, p. 64), click 
on one of the four available Preset buttons.

2.	 In the dropdown menu, choose Save From 
Main or Save From Preview to determine 
which screen you want to memorize the 
preset from.

3.	 Click on the [TAKE] button to view your 
preset on the Main screen.
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Working with Presets

The four OPS300 user presets can be called 
back at any stage during your show or event.

1.	 Click on one of the four available Preset 
buttons to choose which memory you wish 
to use. Select Load to Preview from the 
dropdown menu, your preset will appear on 
the Preview screen.

2.	 Once you have selected your preset, simply 
click on the [TAKE] button to view the result 
on your Main screen.

Working with Audio

The OPS300 allows to work with up to 10 stereo inputs, 1 auxiliary input, and 2 embedded SDI audio inputs 
(via the SDI BNC connectors), all accessible via the Audio menu of the OPS300, and which can be affected 
to one or both of the 2 independent symetrical/asymetrical outputs of the device.

To configure audio settings of the OPS300, plug 
all audio inputs into the device, and click on the 
Audio tab of the RCS home page.

1.	 Set the Main audio output level and delay 
(accessible only if Delay Mode is set to 
Manual Adjust), or click on the [MUTE] 
button to mute Main audio output.

2.	 Repeat step 2 for the Prelist audio output.

3.	 Individual source settings (level and 
balance) for each audio input can be 
configured in the right hand section of the 
Audio tab.

Audio configuration
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Axion2: The Axion2 is an ergonomic and 
reliable remote controller for rental & staging/
multi-venues at an optimal price/performance 
ratio. It controls simultaneously up to 6 screens 
in a single or multiple display configuration. The 
Axion2 integrates a offline mode for setup the 
devices not connected. A sequences mode is 
also available for automatic recall of presets.

OPTIONAL REMOTE CONTROL SYSTEMS

6-1. Axion2

Orchestra: The Orchestra is an ergonomic and 
reliable remote controller for rental & staging/multi-
venues at an optimal price/performance ratio. It 
controls simultaneously up to 6 screens in a single 
or multiple display configuration.

6-2. Orchestra
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6-3. TRK-800

>	� Powerful High End Remote 
Controller

>	� Controls up to 3 different switchers

>	� Mini Joystick for easy element 
control

>	� Ethernet LAN RJ45 connector for 
easy connection

>	� Double Large VFD display 
offering high contrast menu and 
status.

6-4. RK-300

>	� Very User-friendly Remote 
Control Keypad

>	� Controls different Switchers
>	� Mini Joystick for easy ele-

ment control

>	� Ethernet LAN RJ45 connec-
tor for easy connection

>	� Large VFD display offering 
high contrast menu.

NOTE: for further information concerning our optional remote controllers, please connect to our website on:	
www.analogway.com

TRK-800: Triple Remote Keypad designed to control up to 3 units.

RK-300: Remote Control Keypad designed to control Analog Way’s new Seamless Switchers
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Examples are intended to make the use of the OPS300 as easy as possible, by providing visual help in setting 
up your equipment. In an effort to make the use of our machines the most pleasant experience possible, the 
Analog Way team is constantly aiming to create easy to follow examples, update information, and furnish our 
website with useful user information.

Please check on www.analogway.com

EXAMPLES AND TIPS

7-1. ABOUT EXAMPLES

7-2. EXAMPLES

SOURCES

EXAMPLE #1

TYPICAL SCREEN PRESENTATION USING
OPS300 (in Mixer Mode)
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SOURCES

EXAMPLE #2

DOUBLE SCREEN PRESENTATION USING
OPS300 (in Matrix Mode)



74

If you need to use your own Software Control program from a 
PC or automation, the device allows communication through an 
ASCII code protocol. All commands can be found on our website:  
www.analogway.com
All Analog Way products equipped with an RS232 input are 
compatible with Crestron, AMX, Medialon, and most major control 
systems. TCP/IP control ports are also available on most Analog 
Way products, as standard or as options.

To control an OPS300 product with an External Remote Controller 
(PC Software Control - Touch Pad Controller…) follow the indications 
below:

1. First establish an RS-232 communication between the Remote 
Control Software and the OPS300, in order to setup the LAN 
parameters of the product.

2. In the “Control” - “OPS300 LAN Setup” menu, configure the 
connection of the OPS300 product in UDP mode and setup the Local 
and Remote Addresses as well as the Local and Remote Ports in 
concordance with your Network.

3. Configure the TCP/IP address of your External Remote Controller. 
In example: 192.168.000.001

4. Setup the UDP connection of your External Remote Controller in 
concordance with your Network.

In example on the Remote Software in the “Control” - “RS232/LAN 
Setup” - “LAN/Setup” menu.

5. Setup the LAN parameters in UDP mode in the “Console” - “LAN 
Setup” menu.

In example:	 RK Address:		  192.168.000.002
			   Remote Address:		 192.168.000.010
			   Gateway Address:	 192.168.000.001
			   RK Port:			   10500
			   Remote Port:		  10500
			   Netmask:			   255.255.255.000

6. Select the LAN communication port in the remote controller 
console - “RS232/LAN port” menu.

7. You can now control your OPS300 product with an External 
Remote Controller.

7-3. EXTERNAL PROGRAMMING
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WARRANTY

All Analog Way products have a 3 year warranty on parts and labor, back to factory. This warranty does not 
include faults resulting from user negligence, special modifications, electrical surges, abuse (drop/crush), 
and/or other unusual damage.

In the unlikely event that a product is required to return for repair, please call the regional Maintenance 
center / Customer Service, and ask to receive a Return Material Authorization number (RMA). Three regional 
maintenance centers are available depending on your location. See map below for information on which 
regional maintenance center you depend on.

	 RMA Conditions:

	 1. �Prior to returning any item, you must receive a Return Material Authorization (RMA) number.

	 2. All RMA numbers must appear on the return-shipping label.

	 3. All shipping and insurance charges on all RMAs must be prepaid by the customer.

8-1. ANALOG WAY LIMITED WARRANTY

8-2. SERVICES AND RMA

North & South America

Analog Way Inc.
299 Broadway, Suite1620
New York, NY 10007
United States of America

Europe, Middle East and Africa

Analog Way SAS
33 rue du Saule Trapu
Parc du Moulin
91300 Massy - FRANCE

Asia - Pacific

Analog Way Pte Ltd.
No 10 Ubi Crescent
#03-05 Ubi Techpark Lobby A
Singapore 408564
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HOW TO CONTACT US

CONTACT INFORMATION

Analog Way SAS
33 rue du Saule Trapu
Parc du Moulin
91300 Massy 
France
Tel.: +33 1 64 47 16 03
Fax: +33 1 64 47 14 73
saleseuro@analogway.com

Analog Way Inc.
299 Broadway, Suite 1620
New York, NY 10007
United States of America
Tel.: +1 212 269 1902
Fax. +1 212 269 1943
salesusa@analogway.com

Analog Way Pte Ltd.
No. 10 Ubi Crescent
#03-05 Ubi Techpark Lobby A
Singapore 408564
Tel.: +65 6292 5800
Fax: +65 6292 5205
sales@analogwayasia.com

For more documentation, general information, or simply to keep up to date with new releases and upcoming Analog Way 
products, please log on to www.analogway.com.

Before calling your regional maintenance center, please gather the following information: 

	 - Serial number of the unit
	 - Firmware version (look in: CONTROL MENU/VERSIONS)
	 - Model reference (OPS300)
	 - Description of failure

INFORMATION ON UNIT DISPOSAL 

In the European Union:
If the product is used for business purposes and you want to discard it:

Please contact your Analog Way dealer who will inform you about returning of the product. You might be charged for 
the costs arising from returning and recycling.

For Spain: 
Please contact the established collection system or your local authority for take-back of your used product.

In other countries outside the EU:
If you wish to discard of this product, please contact your local authorities and ask for the correct method of disposal.
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